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EMYCSA Overview
RealSimulator

Date: 29-12-2022 Version: 3.01

PICTURE

DESCRIPTION

The FSSB-R3 Lighting is the new standard in high quality force sensors. It puts the
new levels of quality, sensitivity and precision in hard to reach values even for
expensive professional equipment.

The new design of the sensor board gives a tact, smoothness and accuracy of flight
control which makes that the flight experience cannot be compared to anything
experienced before. High-precision maneuvers that are impossible without hundreds of
training hours are now made easily, thanks to the smoothness of control in areas close
to the neutral position.

It is very difficult to express with words the feelings of control that the new R3L sensor
transmits, but after testing it ... you cannot fly without it.

It has provided the new design of a small deflection in the sensor system, which allows
a slight angular movement in the stick, this, although very small, helps to facilitate
adaptation to a force control, which is appreciated in the first flights.

During quality control process, which is done manually to each unit manufactured, the
FSSB R3L is calibrated and adjusted, but has also included an electronic calibration
that allows the user to perform this operation as many times as necessary.

Another new feature included in the FSSB-R3L is the inclusion of special options which
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will be modified according to the needs that users transmit to us. These are some
special options included in the actual firmwares.

HAT as POV or TRIM. The HAT switch can be modified at any time to behave like a
POV (default) or trim command. This allows during the use of the joystick, the HAT
controls the views or submits your information to 4 HID buttons for use as TRIM, which
is its function in real life.

FULL SCALE CONTROL to select between four possible full scale settings of the axes
X and Y, it adjusts the ratio between the applied force to the joystick and the signal
sent to the computer. Although this looks like a sensitivity adjustment, control is not
exactly the same. This setting is ideal for adjusting joystick response in complex
situations, such as a landing, refueling maneuver, ground attack. The setting values
are FSC 1:13:41:41:2

NEUTRAL POSITION ADJUSTMENT. The adjustment of the neutral position manually
allows exact adjustment of the neutral position of FSSB R3L. In previous models R1
and R2, this adjustment was done through potentiometers on the electronic board, now
is done using digital potentiometers, which are adjusted by the firmware when the user
need, including in the middle of a flight mission.

SOUNDI/LIGHT. These two options let you independently enable or disable the beep
sound and light signals.

WARNING SOUND LEVEL. Set the percentage for the warning sound level from 1 to
99% and calculated with the actual sensibility and full scale control in 4:4

BFA LEVEL. Adjustable independently in Roll and Pitch, let you select in four steps
from 0 to 10% the level of force applied to break the stable cero position.

MEMORY SLOTS. Four memory slots to save/load custom configurations with
compatible TM grips and 8 memory slots with RS grips.

As other Realsimulator devices, the FSSB-R3L is firmware upgradeable. At the
moment there are the following firmwares available:

e MJF_FW: standard version for modern jet fighters.
e SSF: version for space ships fighters.
e SSF_LH: special version of SSF for left hands users.

Beside the above characteristics, the product is supplied with a firmware update tool
(DCC) to install new versions of firmware and a GUI application (RS_HID_DEV_TOOL)
to configure the device. Both tools can be downloaded inside the same package from
the download’s website.

https://realsimulator.com/downloads/

This User Guide is valid for the FSSB-R3 Lighting model. If you have doubt about the
model you have purchased, you can identify it easily by the aluminum case and the
label. Here you have some pictures to clarify the identification.
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https://realsimulator.com/downloads/

FSSB R3 Warthog FSSB R3 Lighting FSSB R3 Lighting

Aluminum case: Natural color Aluminum case: natural color Aluminum case: natural color
Label: Aluminum/Black Label: Gold/Black Label: Gold/Gray

(Current model since 2020)

‘?lEI\LSlHUlJ\TCI
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L

FSSB-R3L MKII ULTRA

Aluminum case: Light titanium or
natural color
Label: White/Black
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EMYCSA Package Content and Technical Data
RealSimuIator Date: 29-12-2022 Version: 3.01

PICTURE

DESCRIPTION

Package content

FSSB-R3L is supplied as a plug and play device with no drivers. It needs a small and
quick hardware installation as you can see in the next chapter. The package, showed
in the before picture, contains the following components:

e FSSB-R3 Lighting device.
e USB wire (USB type A to mini USB type B).
e Auxiliary 6-pin to 5-pin cable for TM Warthog board.

Technical data

¢ Independent force sensor for each axis.
e Black anodized fixation element for stick.
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Functional with Cougar or Warthog stick.

HOTAS Warthog electronic board fixation by 2 M3x5 screws.
Measurement electronic with separate channels.

HAT as POV or TRIM.

Electronic neutral position adjusts.

Acoustic advice.

RGB Light advice.

Two expansion sockets.

Double USB connection: external mini-USB type B and internal JST 5-way type
B5B-PH-K-S (only in devices sold from June 2022).

Full scale control with 4 levels, 1:1, 3:4, 1:2 & 1:4.

Sensibility control for Roll in 4 levels. 2.5, 4.5, 6.5 and 13 pounds.
Sensibility control for Pitch in 4 levels 4, 6, 9 and 13 pounds.

2nd and 3rd DX button set (available in some firmwares)

2nd and 3rd DX button set ON/OFF control

4/8 Memory Slots for quick custom configuration in function of firmware
Auto-Load Memory Slot #1 if available

Firmware upgrade.

One piece aluminum white anodized case.

Fixing screws not included, they are supplied with the base plate (M4x10 mm)
Electric connections made by connectors. No soldering required.

USB connection cable included (1,8 m).

Max. applied force 13 Ib.

Max. allowed force 20 Ib.

Dimensions (W x D x H): 98 x 98 x 60 mm

Weight. 350 gr.
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EMYCSA Installation

Rea|S|mUIat0r Date: 29-12-2022 Version: 3.01

PICTURE
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DESCRIPTION

The FSSB-R3L can be used in two ways, as an upgrade for the HOTAS Warthog or
independently as a standalone joystick. In both cases, for its installation the following
tools are needed:

- Philips PH1 screwdriver.
- Flush cutter (or scissors)

Standalone joystick

If you are going to use the FSSB-R3L as a standalone joystick, you only have to
connect the FSSB-R3L to your computer via the USB wire found in the package and
the FSSB-R3L will be recognized directly as an HID device.

You can use any Windows tool for game devices compatible with HID, and the joystick
will be displayed on all applications that can handle HID devices with the name "FSSB
R3L MJF J+B".

The installation is very easy and fast. You will need a plate to fix the FSSB-R3L. If you
have the HOTAS Warthog you can use its plate, if not, you must manufacture a plate
or buy it in our website, now it is available in the shop.
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If you are going to manufacture it, below we show you a picture of Warthog plate with
the dimensions and holes. You can download it from the Thrustmaster website
(Warthog_plate).

272

258

C/gé 45

60.1 193 232

@5\

. |
S .

60.1

Hotas Warthog Joystick Plate
Dimensions in mm

We have made a video guide called “FSSB-R3 Warthog Alone” where you can watch
step by step how to install the FSSB-R3. You can find this video guide on
RealSimulator FSSB-R3 Lighting video gallery:

(https://realsimulator.com/download/videos/FSSB R3 Warthog Alone.mp4)

or, directly clicking the next image or hyperlink

What do you need

FSSB R3

.

Screwdriveé

P »lI o) 0:00/3:09
FSSB-R3 Warthog Alone Installation
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http://ts.thrustmaster.com/download/accessories/pc/hotas/manual/HOTAS_Warthog/HotasWarthog_Plates.rar
https://realsimulator.com/download/videos/FSSB_R3_Warthog_Alone.mp4
https://www.youtube.com/watch?v=fX4pCziq03E
https://www.youtube.com/watch?v=fX4pCziq03E

As the grip connector of FSSB-R3L is compatible with the Thrustmaster sticks, you will
be able to connect any grip compatible with them to your FSSB-R3L.

So for example, you could renovate your old Cougar system with a few Realsimulator’s
devices. You will only need the above mentioned plate to screw the FSSB-R3L, a
TUSBA to connect the Cougar Throttle and your actual Cougar grip.

In this User Guide you will find a special chapter focused to the new Realsimulator’s
grips, as the F16SGRH, when is connected to the FSSB-R3L, thoroughly explaining all
the new features that both devices offer when they work together.

Upgrade for the HOTAS Warthog

In addition to the advantages offered by the use of the FSSB-R3L standalone, this has
connectors that allow you to send data from FSSB-R3L to the TM HOTAS Warthog

electronic board.

For installation using video guide called “FSSB-R3 Warthog HOTAS Upgrade” that
you can find on the RealSimulator FSSB-R3 Lighting video gallery:

(https://realsimulator.com/download/videos/FSSB R3 Warthog.mp4)

or, directly clicking the next image or hyperlink

P Pl o) 335/6:17

FSSB-R3 Warthog HOTAS Upgrade Installation

When used with HOTAS Warthog electronics, you can connect both USB cables to the
same computer and choose with your computer which joystick use. Obviously, the user
can configure the simulation program, using both, the HOTAS variables and buttons as
well as native FSSB-R3L variables and buttons, being limited only through the options
of the software you are using.

As a rule, the HOTAS could benefit from both, the high quality of X and Y data axes as
well as some special modes of FSSB-R3L.

Finally, I want to inform you that we have detected Thrustmaster Warthog stick bases
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http://www.realsimulator.com/html/tusba.html
https://realsimulator.com/download/videos/FSSB_R3_Warthog.mp4
https://www.youtube.com/watch?v=zdocudYw2dw
https://www.youtube.com/watch?v=zdocudYw2dw

with a new electronic board; on these new pcbs the J1 connector is a 5 pin instead 6
pin as previously. So, if this is your case, we send you an additional cable with a 6 pin
connector in a side (to connect to the J6 socket of R3L) and a 5 pin connector in the
other side (to connect to the J1 socket of TM pcb) to replace the standard 6 pin cable
supplied and connected with the FSSB-R3L.

Connect here the new cable 5 \’\¢ ,_ S\ o

to 6 pins supplled ’
/

New hcb with 5 pin connector on J1

6 Pin Connector 5 Pin Connector
To the R3L To the TM pcb (J1)

Internal USB Connector

Now, all FSSB-R3 Lighting sold since June 2022 have a dual USB connection, the
external and traditional through a mini-USB type B connector and an internal one
through a 5-way JST connector (B5B-PH-K-S).

This new connection is designed for assemblies where the traditional USB connector is
left in the air without protection, as it happens when using the very fashionable chair
supports for joysticks. In these cases, when the USB connector is in the air without
protection, it can receive accidental blows that will end up spoiling the USB cable or
the R3L connector.

147110




With this new connection, the cable comes out from inside the FSSB-R3L and thus
avoids rigid parts external to the FSSB-R3L, such as the USB cable connector.

15/110




EMYCSA First Connection

Rea|S|mUIat0r Date: 29-12-2022 Version: 3.01

PICTURE

DESCRIPTION

The first time that you connect your FSSB-R3L in your computer, you will take notice
about really your FSSB-R3L are several devices living in the same hardware. In fact,
inside your FSSB-R3L there are:

e A Boot system, to allow you to update FSSB-R3L with new firmware.

e A HID Game Device, to let you communicate FSSB-R3L directly with MS
operating system and let you control your simulator or some other game with
DX axes and buttons.

e A mouse and a keyboard.
e An additional comms port for special comms with the device.

As soon as you connect FSSB-R3L, MS operating system will detect it and will start
looking in its data base to install the appropriate drivers for it. We have avoided custom
drivers or additional special system in order not to have any problems in the future with
new MS operating systems. Just as you know, every time MS improve its OS, all of us
have a headshake with incompatibilities, drivers, etc. so we have learnt from the past,
that the best is to use the own legacy MS drivers for comms and this is what we have
done in the FSSB-R3L system, use only MS drivers, so when you connect your FSSB-
R3L to the computer, MS will look in its data base for the best MS driver for it, in fact its
own HID drivers.

The first device to look for drivers is the FSSB-R3 Bootloader system, and a few
seconds after taking comms with the operative system, the FSSB-R3 Boot will left the
system and will be disconnect to allow working the Game device and the other
additional HID devices.
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< B X

FSSBR3
Bootloader

()

Sometimes the Boot device goes out and it is not fully installed, if this

happens, don’t worry, it will be installed in another occasion or when you
upgrade the device.

As soon as the Boot goes out a USB Composite Device with several USB Input
Devices will start looking for drivers. As these HID devices will not go out from your
system, after a few second you will see as your OS will found the drivers and install

them in your computer and the USB Composite device will be shown in the Devices
and Printers window.

 Mouse settings
E=2 Keyboard settings

g ’ €2 Region and language

% Game controller settings

R3L MJF J+B

Create shortcut

& Remove device

Troubleshoot

Properties
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EMYCSA Tools Installation
ReaISimuIator Date: 29-12-2022 Version: 3.01

PICTURE

18 RS_TOOLS_V1_02 - InstaliShield Wizard ¥

Welcome to the InstallShield Wizard for
RS_TOOLS_V1_0D2

The InstallShield(R) Wizard will install RS_TOOLS_V1_02 on
your computer, To continue, dick Mext,

WARNING: This program is protected by copyright law and
international treaties,

DESCRIPTION

The product is supplied with two software tools, a firmware update (DCC) to allow
installing new versions of firmware in the device and a GUI application
(RS_HID_DEV_TOOL) to configure the device.

Both tools can be downloaded from the Downloads page of RealSimulator website
inside the same package. The package also includes the RealSimulator device
metadata files, the latest firmware and the product User Guide.

To download the tools, please, go to the Downloads page of the RealSimulator website
by clicking the hyperlink below:

https://www.realsimulator.com/downloads/

and download the latest version of RS_TOOLS and save it in a location of your choice.

If you have a previous version installed, please uninstall it before installing
the new one, although the latest installers automatically remove the previous
versions of RS_TOOLS.

System requirements are:
e Microsoft .NET Framework 4.5.2
e Microsoft Visual C++ 2017 Redistributable (x86).

Although you don't have to worry about installing them, the installer will do it for you if
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your computer needs it.

In platforms with Windows 8.1 or higher, “DCC” tool will be installed (with support for
BLE devices). In previous versions of Windows, the package installs a “light” version of
the program without support for BLE, named “DCC v1.xx (NO_BLE)”. This version
does not allow upgrading BLE devices as the RS grips (F16SGRH / FI8CGRH).

To start the installation, run the downloaded program by double-clicking the file icon.
Presently, the file is named “setup RS _Tools V1_02.zip”, but the procedure will be

identical with any new version.

Any case, you should have a window like this one.

File Commands ites  Options  Help
—: 13
-
=c RN b o G ¥
Al I =z
Add Bxract To Test View Delete Find Wizard Info VirusSean Comment  Protect SFX

Name Size Packed Type Modified CRC32

[
[ setup_RS_Tools V1_02.exe 28981936 28476411 Aplicacién 11/07/2019 18:44  SDAF295D

=L Total 28.981.936 bytes in 1 file

where setup_RS_Tools_V1 02.exe is the tools installer. To install it, please, run the
file with a double click on the file name.

After a few seconds extracting and decompressing the package, the installation wizard
will launch. Select Next to continue.

4] RS_TOOLS_V1_02 - InstallShield Wizard x

Welcome to the InstallShield Wizard for
RS_TOOLS_V1_02

The InstallShield{R) Wizard wil install RS_TOOLS_V1_02 on
your computer, To continue, dick Next.

WARNING: This program is protected by copyright law and
international treaties.

A standard licensing agreement must be accepted before moving on. Choose | accept
the terms of the license agreement and click Next.
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35 RS_TOOLS_V1_02 - InstallShield Wizard X

License Agreement

Flease read the following license agreement carefully.

[END-USER LICENCE AGREEMENT -

IMPORTANT - YOU SHOULD CAREFULLY READ THE FOLLOWING
[BEFORE INSTALLING THE SOFTWARE.

[USE OF THE SOFTWARE IS5 SUBJECT TO THE LICENCE TERMS SET
FORTH BELOW. THI5S LICENCE AGREEMENT (“LICENCE”) I3 A
LEGAL DOCUMENT BETWEEN YCU (“LICENSEE” CR “YOU”) AND THE
ELECTRCNICAZ, MECANICA Y CONTRCOL, S.A., AVDA. MANCTERAS

22, NAVE 42, 28050, MADRID, SPAIN (“EMYCSA” OR “WE") FOR v

lruT woeoD o TETTY CATTMART MDARNTTAT I ANDACTIAMTL  MOTen

()1 accept the terms in the license agreement Print

(®)1 do not accept the terms in the license agreement!

Instalishield

< Back Mext = Cancel

If you want to install all program features (DCC, RS_HID DEV_TOOL, Metadata files,
firmwares and User Guides) select the Complete setup type and click Next to
continue.

# R5_TOOLS_V1_02 - InstallShield Wizard X

Setup Type
Choose the setup type that best suits your needs.

Flease select a setup type.

All program features will be installed. (Requires the most disk
space.)

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

InstallShield

==

Or select Custom if you want to choose the features to install and click Next to
continue.

ﬁ RS_TOOLS_V1_02 - InstallShield Wizard x

Custom Setup
Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.
RS_HID_DEV_TOOL Feature Description
DCC
Firmware
Metadatas
Documentation
This feature requires 5728KE on
your hard drive.
Install to:
C:'Program Files'\RealSimulator Code\RS_HID_DEV_TOOLY Change...
InstallShield
Help Space < Back Cancel

The wizard is now ready to start the installation. Please, click on Install.
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ﬁ R5_TOOLS_V1_02 - InstallShield Wizard X

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Installshield

< Back *,m Cancel

If the User Account Control window appears, click the Yes button to continue.

Q User Account Control *

Do you want to allow this app from an unknown
publisher to make changes to your PC?

Program name:  Ch\Users\YO\AppData'Lecal\.. \RS_TOOLS_V1_02.msi
Publisher: Unknown
File origin: Hard drive on this computer

() Show details Yes

Change when these notifications appear

The installation of RS_TOOLS_V1 02 may take several minutes to complete.

ﬁ R5_TOOLS_V1_02 - InstallShield Wizard —

Installing RS_TOOLS_V1_02
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs RS_TOOLS_V1_02. This
may take several minutes.

Status:
Publishing product information

Installshield

< Back MNext =

Wait until the wizard finishes the installation and click Finish.
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y RS_TOOLS_V1_02 - InstaliShield Wizard X

InstallShield Wizard Completed

The InstaliShield Wizard has successfully installed
RS_TOOLS_V1_02. Click Finish to exit the wizard.

The installation is now finished and the programs are ready to use.

If you have connected to the PC your FSSB-R3L, you can see a new device image in
the Devices and Printers window.

For this, click in the windows START button and select Devices and Printers. You
should see an icon device like these

&5 De.. — [m] X s — O >
« v 1 & « Hard... 3 “ v A e« H
» =l
° . - e
~
VLM IJF-J IuDLs
R
FSSB R3 Warthog FSSB R3 Lighting
~ Multimedia Devic... (1) , B v
< > c
) 14 ite...
. ] 16items ?
- ’ur ﬁ‘
FSSB-R3 Lighting with SSF firmware FSSB-R3 Lighting with MJF_FW_F16-18_5

NOTE: sometimes Windows does not update immediately the icon device
and you see the standard game device icon, in those occasions press the
F5 key to force windows to update the icon devices cache.

In addition, after the installation, you will find two new icons on your desktop: the DCC
and RS_HID_DEV_TOOL application shortcuts.
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Finally, if you press the windows START button and look the All App section in the “R”
letter you will find in the Realsimulator folder shortcuts to the DCC and
RS _HID_DEV_TOOL programs, the RealSimulator devices User Guide and the FSSB
R3 BluePrint.

R Calendar
. Realsimulator EW A~

% b New e
F165GRH_EN Mew

Microsoft Edge

F165GRH_FR
Mostly Cloudy

FSSBR3 New 41° 43

FUSBA
e . : Washington.... Phone Compa...
“ RS_HID_DEV TOOL

:> % RS HID_DEV.TOOLV1Z  New
RUSBA O a i
TUSBA
S
£¥  Settings

e Back

|'m Cortana. Ask me anything.

IMPORTANT: Additionally to the main and last version of
RS_HID_DEV_TOOL whose icon is on the desktop, in the Realsimulator
folder shortcuts you will find an icon with the direct access to the v12 of
RS_HID_DEV_TOOL, program necessary to configure firmwares of R3
Warthog and classic firmwares of R3 Lighting as the SSF. If you have to use
this program, we suggest that you copy the shortcut to the desktop for an
easy access.

The applications are installed in the following folders:

C:\Program Files (x86)\RealSimulator Code\DCC
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C:\Program Files (x86)\RealSimulator Code\RS_HID_DEV_TOOL
The User Guide, Metadata, Firmware, BluePrint files and Templates are in:

%APPDATA%\Realsimulator Data\

24 /110




EMYCSA Firmware Update
ReaISimuIator Date: 29-12-2022 Version: 3.01

PICTURE

Device Control Center V-1.05.0 - O e

File (.FSSB_R3)

ChUzers\Bartolome\&pplata\Reaming\RealSimulator Data\FSSB R3IWJIF_FW_1_05_2 FSSB_R3

F35BRIFVIU CCDHFWU CCDKFWU TUSBAR2? RUSBA FUSBA

Status Instructions

Dizconnect your FSSB R3

R3 Disconnected HOTAS Disconnected

Select the firmware to update

R3 Connected

R3WMJF_FW_1_05_2.FSSB_R3 A
Firmware selected, please connect your device to start the updating.
Updating ... please do not dizconnect your device.

Started at 09/05/2016 17:18:11

progress |

EMYCSA WWWW.RealSimulator.com

DESCRIPTION

Usually, you will receive your RealSimulator device with the last firmware version
installed of MJF firmware, so it will not be necessary to use DCC to update your device
immediately after its reception, unless you want to install another customized firmware,
as SSF.

If you check the product site periodically you could find new versions with
enhancements and issues fixed, so you will need to use the DCC program.

To start the DCC program, launch it by double clicking the DCC desktop icon or click in
the windows START button and select All Program > Realsimulator > DCC. If the
User Account Control window appears, click YES to continue.

) User Account Control *,

Do you want to allow this app from an unknown
publisher to make changes to your PC?

Program name:  DCC.exe

Publisher: Unknown
File origin: Hard drive on this computer
Show details Yes

Change when these notifications appear
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Select the tab labelled as FSSB R3 FWU and follow the instructions given in the
groupbox Instructions to update the device.

Disconnect the FSSB-R3L and HOTAS Warthog (if it is installed and connected) from
computer, unplugging the USB cables. If DCC detects the devices connected, the
instruction messages will be in red and when the devices are disconnected the
messages will be in green. The update sequence will pass the next step when both
devices will be disconnected.

() Device Control Center V-1.05.0 - O e
File {.FSSB_R3)
F3SBRIFVIU CCDHFWU CCDKFWU TUSBAR2 RUSBA FUSBA
Status Instructions
| Disconnect your FSSB R3
| Disconnect R3 HOTAS Disconnected
| Select the firmware to update
| Connect your R3
Progress
20132014 EMYCSA WIWW.RealSimulator.com
FSSB-R3L connected and HOTAS Warthog disconnected
@ Device Control Center V-1.05.0 - O x
File ( FSSB_R3)
FSSBR3IFWU CCDHFWU CCDKFWU TUSBAR2 RUSBA FUSBA
Status Instructions
| Disconnect your FSSB R3
| R3 Disconnected HOTAS Disconnected
| Select the firmware to update
| Connect your R3
Progress
©2013-2014 EMYCSA WWWWW RealSimulator. com

FSSB-R3L and HOTAS Warthog disconnected

As you can see in the previous picture, Status groupbox shows a light device image, it
is normal, this image will only be in normal colour when the device is running the
bootloader program, in other cases, with the device unplugged or in normal operation
the image will be light.
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Now, the Select the firmware to update message will be blinking in red, so click the
Load button to open the Open Firmware File window to select the new firmware to
install, select the desire file clicking the filename and click the Open button to close the
window.

Open Firmware File X
ok <« RealSimulato.. *+ FSSBR3 » v O Search F55B R3 o
Organize v New folder = [ @
AppData * Name Date medified Type ™
Local Doc File fol
Locallov [ ] AER_FW_1_00_0.FSSB_R3 FSSE_F
Roarming | ] AER_PW_2_00_0.FSSB_R3 FSSE_F
Adobe [ ] BMS_FW_1_02_1.FSSB_R3 FSSB_F
Macror [ ] BMS_FW_2_00_D.FSSB_R3 FSSE_F
GRI_FW_1_00_0.FSSB_R3 FSSB_F
Micros: U - - - -
[ ] LC)FW_1_01_0.FSSB_R2 FSSE_F
Realsirr
[ ] LCI_FW_2_00_0.FSSB_R3 FSSB_F
RealSin [ MIF_FW_1_05_2.FSSB_R3 FSSE_F
CChDr [ ] MUF_FW_2_00_0.FSSB_R3 FSSE_F
CCDK [ ] SSF_FW_1.00_0.FSSB_R3 FSSE_F
FSSE | || SSF_FW_2_00_0.FSSB_R3 y FSSB_F w
.. L4 >
Hmnama“ v| F5SB_R3 file (*FSSB_R3) -

IMPORTANT NOTE:

Remember this when you go to choose a firmware to install in your R3. You must pay
special attention in the next number:

e Num. “1”: it is the firmware for the FSSB-R3 (Warthog), as for example:

- MJF_FW_1 06 _2.FSSB_R3: firmware to work with Thrustmaster compatible
grips like Cougar and Warthog.

- MJF_FW_F16_SG_1 00_1.FSSB_RS3: firmware to work with the RS grips.

e Num. “2”: it is a firmware for the FSSB-R3 Lighting, as for example:

- SSF_FW_2 00 _2.FSSB_R3: firmware to work with Thrustmaster compatible
grips like Cougar and Warthog.

e Num. “3” and “4”: firmwares deprecated

e Num. “5”: it is the firmware for the FSSB-R3 Lighting to include support for the
new Realsimulator v2 grips, as for example:

- MJF_FW_F16-18 5 01 0.FSSB_RaS: this firmware includes latest features for
the R3L and support for RS grips (F16 and F18) and TM compatible grips. It is
the most advanced version with support for RS v2 grips and only include one
HID game device.

With the previous message in green and if the HOTAS Warthog is unplugged
(message “HOTAS disconnected” in green), the following message Connect your R3
will blink in red.

NOTE: It is absolutely necessary unplug the USB wire of HOTAS Warthog electronic
pcb, if not, the DCC program won’t request you “Connect your R3”.
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@ Device Control Center ¥-1.03.0 - O X

File (FSSB_R3)

C:\Users\Bartolome\AppData\RoamingiR Data\FSSB R3WJF_FW_1_05_2 FSSB_R3

FSSBRIFWU CCDHFWU CCDKFWU TUSBARZ RUSBA FUSBA

Status Instructions

| Disconnect your FSSB R3

‘ R3 Disconnected HOTAS Disconnected

‘ Select the firmware to update

‘ Connect your R3

C:\Users\Bar ppData‘\Ri g\R Data\FSSB
R3WWJF_FW_1_05_2 FSSB_R3
Firmware selected, please connect your device to start the updating.

Progress

© 20132014 EMYCSA WWW RealSimulator.com

To start the updating we must plug in the FSSB-R3L USB cable, which will launch the
bootloader for some seconds and DCC program will start the communications with the
device sending the new firmware. During this data transference we will be able to see
the progress in the Progress bar and the status image in normal colour.

@ Device Control Center V-1.05.0 — O X

File (FSSB_R3)

C\Users\Bartolome\AppData\Roaming\RealSi Data\FSSB R3WJF_FW_1_05_2FSSB_R3

FSSBR3FWU CCDHFWU CCDKFWU TUSBAR2 RUSBA FUSBA

Status Instructions

| Disconnect your FSSB R3

| R3 Disconnected HOTAS Disconnected

| Select the firmware to update

| R3 Connected

RAWMIF_FW_1_05_2FSSB_R3 A~
Firmware selected, please connect your device to start the updating.
Updating ... please do not disconnect your device.

Started at 0/0S/2016 17:18: 11

progress R

© 20132014 EMYCSA WWW RealSimulator.com

Finally, when the update finishes the device will exit from the bootloader program and
will run the new firmware.

DCC program will show a new window to confirm the firmware update completed
successfully and it will ask you to continue with another device or exit.

Click Yes to exit.

Firmware update completed successfully

o Yes to EXIT or Mo to CONTIMUE

Yes No
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EMYCSA RS _HID DEV_TOOL and FSSB-R3L
RealSimulator

Date: 29-12-2022 Version: 3.01
1%% RealSimulator HID Device Tool V1.13 — x
File Help
(FSSERIRH! FSSBR3LH TUSBAR2 RUSBA FUSBA Magind & SpeedBroke FI6/F18RH F16/18LH Thtie Rudder
BMS433u1 Slot 1 Slot Name-> Explanation Names
Fimware MUF_FW_4 000 e 57 Drectxbutton
Keystrok o on W o f 0 162, [ Jo @20, | Jo [48% [ ]
HAT TRIM TRIM P Jo 17 | Jo 138 | Jo 45 | |
Sound on on 5l =" o [isle, o [3e, 0l
P | BEE o [19% %5° 51°
Light on ON Y] @ 0 ° 36 ° o [52°
DX Button ON ON Pl e 210 o [379, 53
DM (FSC) = A
FullSede Core = s | [eme 2° o [38% ]
: 1| a o . =
— 240, 40 % 56
[esoe | - (e %° e, 57
NASA Pich Sensibilty % o o %0 o [42° 58
R
i 77\ 43 % 59
Rl Control Assistance (RCA} OFF OFF 20 280 o [48°
[ o
BFA Rol level 3 a9, 250 50, 61
BFAPtchlevel | Med |13 e, e o [M°, (5]
Precision Mode | ger =] [orF 5o, 31 a7°, 63
Output

DX Center Buitons ON oN
Waming Sound Level | 807 |12 8%
Digtal Mouse Swich | None |15 None

 E=mED

1 — Axes Meas:

I Absolute v El :
‘ TimRol [ g | RelX
Timpren [ 0| PtehY

PITCH

.
Hardware TRIM Bath | [ Both
Set Tim Button | cpms ||+

v
ROLL

Reset Trm Button [ padde | &

MACROS

Overlay Setings

Game Mode

Conf Made: nde

Adiust W] DX Measures =] Raw Measures

WWW RealSimulator com

DESCRIPTION

Overview

RS HID_DEV_TOOL is a GUI developed by RealSimulator to facilitate the
configuration of devices manufactured by RealSimulator. In general, it allows
calibrating, customizing and adjusting easily the different options offered by the device
to get the maximum performance from your hardware.

FSSB-R3L is a product closed that includes the force sensors and electronic for
measure and communications and it does not need external hardware, except the
stick. During the quality control process, which is done manually to each unit
manufactured, the FSSB-R3L is internally calibrated and adjusted although it has also
included an electronic calibration that allows the user to perform this operation as
many times as necessatry.

So, we only suggest using this tool to configure and calibrate the FSSB-R3L and
do not use the standard tool of Windows, the Game Controllers window.

If you have used any time this tool to calibrate the FSSB-R3L we suggest you using
the “Reset to Default” button of Settings tab of FSSB R3L MJF J+B properties
window to delete the calibration made and set the calibration values to default.
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#¥ Game Controllers X

- These settings help you configure the game controllers installed on
"; your computer.

Installed game controllers

Controller Status
FSSB R3L MJF J+B OK

Advanced... % Properties

& FSSB RIL MJF J+B properties
Seings Teat

Game Controller Caiibration

if your game controller s ot functioning propery on the Test page. it
may need ta be calbreted. Click Calibrate and folow the instructions to

calibrate the controller
Resetto aEsun Calibrate.

Cancel Aoply

The RS_HID_DEV_TOOL program

In this section we will give you a general overview of the RS HID DEV_TOOL
program working with the FSSB-R3L.

To start,

launch the RS HID_DEV_TOOL application by double clicking the
RS_HID_DEV_TOOL desktop icon or click the Windows START button and select All
Apps > Realsimulator > RS _HID DEV_TOOL.

If the User Account Control window appears, click YES to continue.

&) User Account Contral

Program name:
Publisher:
File origin:

() Show detsils

X

Do you want to allow this app from an unknown
publisher to make changes to your PC?

RS_HID_DEV_TOOL.exe
Unknown
Hard drive on this computer

=

Change when these notifications appear

Select the “FSSB R3 RH” tab and you should see the following window, where we
have identified with numbers the different information and configuration areas.

([
o -

13§ RealSimulator HID Device Tool V1.15.1 _ %
File  Help
FSSBR3RH FSSBR3LH TUSBAR2 RUSBA FUSBA Magind & SpeedBake F16/FI8RH F18/18LH Throttle Rudder
Fimware MJF_FW_5_01_0 i ot Eplmaten b
WS 00 g7| DiectXbutton
Kerkes[on o = o 1562, o, o 2% o 8, s -
HAT | TRIM TRIM ] (7 [ |- [ o — o k
o - - ¢ 30, [Dhte, o 7810, o [389, [e, o [509, [LOtIF3, o
Pl B% |k o [199, |LShftLAR Up, o [35°% |1, o [51 %, [LCtF1, )
Light ON ON Y| o, [Cenmk o 200, o [36 %, [Ke1, o [82% |5, o
DX Button ON £l s o [21°, [LShm LAt Down, o [37°, [Kp2, o [53% |6, o
ot S Cariel E 5 | 62 [keEnter . 2% o [38% ko2, o[58 1 ’
Rol Sensibiiy s [soom | Ll e, ke, o [0, 1. o [39%, [Kpd, o [55% |8, c
NASA Roll Sensibity 30, [F4, o [0, |2, o [40°, [Kps. o[58, [Lomp, a
Pitch Sensbiity 50, 0 (350, [3. o (&2, [Kps, o [57% [Lsnttb, o
NASA Pich Sensbitty I [10°°, [LCH Home, o [26% [4, 3 yTz’,J Kp7, o (53 % |LShti, a
[77 %, [LCti,Next, o [279, o (439, |Kps, o[58, C
Roll Control Assistance (RCA) OFF OFF [12°, [LotEnd, o 289, o (880, [Kp+, o [601%, a
BrARdlevel [ Mn [i e | [13°, [LCt Delste, o [, o [45% [Kpg, o [61% e
BFAPtchievel [ M [E] [T | 74, [Up, 0 [30%, o [46 % [Kp-, o [62% o
Precision Mode | orr 2] [ore [35°, [Riont, o 310, [B o [&7 9, [Kpo, o639, a
Output
DX Center Buttons ON oN
Wanming Sound Level | 80% |1 % @
Digtal Mouse Switch
Digtal Mouse Speed | Axes Measure D G
Digtal Mouse Button Absolite - =
Digtal Mouse SimButton ‘ TrmRol g | Ronx [ 1768 |
Shiter Button
e [ TimPteh [ p | Preny Rz
Toggle Buton
Toggle Sit Number
Hardware TRIM » 3z
Set Trim Button &
Reset Trim Button
o WMACROS
Overlay Settings
® Game Mo e
Adiust m DX Measures B Raw Meastres

MWW\ RealSimulator com
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Below we present you a description of each area of previous image; we
want to inform you that some images have not been updated and they are of
previous versions, but they show you the necessary information.

Area showing the firmware version installed in the device and the name of
xml file containing the configuration and keystrokes settings.

'351, RealSimulator HID Device Tool V1.15.1

File Help
FSSBR3IRH FSSBR3LH TUSBAR2 RUSBA FUSBA
BACKUP Slot 1
Fimware MJF_FW_5_01_0 Load

Keystrokes ON o

Informative area with the settings for the presently Active Configuration and
Slot Configuration. Slot 2 is shown in this picture. User can only modify the
settings in the presently active configuration, in the left column. Below you will
find a complete explanation about how they work.

BMS433uT Slot 2 Slot N BMS433u1 2 ) Sot 1
Fimware MJF_FW_3.203 (| 1o g | Drect L N Il g Diec
EERE &g ON | o - oN oN o Slot
B [ Active r Configuration
HAT .| configuration RaT | LEDY Pov — L
Sound o Sound ON oN é T
Light ON Y| e Light ON ON Y ¢
DX Button on Pl ga Button ON ON 5 ¢
DMS (FSC) A DMS ( . -
o= g oo N |
NASA Roll Sensibiity = ; o NASA R:u s::b:lz ; £l 7 Z
Pitch Sensibilty — Pitch Sensibity + . ‘
: 9
NASA Pitch Sensibilty 0 NASA Pitch Sensibiity : o
T p
Roll Cortrol Assistance (RCA) OFF 50 Roll Control Assistance (RCA} OFF OFF 1; ¢
BFA Rol level 3 e BFA Rol level 5 =
BFA Pich level z - BFA Piich level : ¢
Precision Mode | orr =] |orF 50 Frecision Made | [ orr = |/orF 75
Outpt Qutp
DX Center Buttons ON DX Center Buttons DClick DClick
Waming Sound Level 2 |: Waming Sound Level 5
Digtal Mouse Switch Digtal Mouse Switch :
Digital Mouse Speed < Digital Mouse Speed 5
Digital Mouse Button S Digital Mouse Button 5
Digital Mouse SimButton = Digital Mouse SimButton <
Shifter Button S Shifter Button = 4
Shifter Sit number ® Shiter Siot number :
Toggle Buton S Toggle Buton 5
Toggle St Number = Toggle Slot Number 3
1 \_ N J

The buttons with a grey background have, in most cases, two options. The
active option is shown in the button, while the alternate option will be displayed
when the button is pressed. The image above the HAT button shows the
“TRIM” option. If you press the button, it changes to the other possible state,
‘POV”.

To change the information shown in the white textboxes, you have to click the
numeric Up/Down control associated, the values will change between the max
and min values assigned to that setting.

Animated area where the program graphically shows the buttons and hats
actions of the stick.
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4. Buttons to select the Configuration or Game mode, button to launch and
configure the Overlay and button to open the Macros window. Below you will
find a complete explanation about these features and how they work.

5. Animated area where shows in an X/Y graphic the Roll and Pitch measures.
The actual measure is showed with a red pointer.

EI - PITCH
4
B» o A
S [
Angle H H ! '_ H H
Adjust (] D% Measures [B] Raw Measures

6. Groupbox with the axes measure, in this case Roll (axis X) and Pitch (axis Y).
This information is showed numerically on text boxes and can be showed in
Absolute or Percentage format. To change it, select the preferred option in the
combo box.

Fues Measure Fes Measure

| Absolute w | | Percentage v |

Roll X Roll X 0%
Pitch Pitch ¥

Next to this groupbox is located two textboxes where are shown the trim
values. You will see a detailed information about how it works in the Trim

section.
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Axes Measure

| Absolute w

[0 | Roix
TrmPich [ g | PichY

Trim Roll

7. Text window named Output to test the keystrokes.

8. Configuration area for keystrokes and explanations assigned to each slot and
DX button status. When you press a button, the assigned DX button turns on
and the keystroke is shown in the Output box. This area contains a textbox for
the slot names, buttons to SWAP, COPY, PASTE and CLEAR the slot
information and two buttons to show Keystrokes/Explanations and buttons
names.

9. Menu strip with functionality to Save and Read configuration .xml files, Print
the keystrokes templates and DOC to access to the pdf documentation.

In general, every button, group box or numeric Up/Down control in the window has a
small pop-up box (tooltip) with basic information about it. This information will appear
when the mouse pointer is over the control.

1%% RealSimulator HID Device Tool V1,12

Eile  Help
FSSBR3RH FSSBR3LH TUSBARZ2 RUSBA FUSBA Magind & SpeedBrake F165GRH F16SGLH F18CGRH F18

BMS4T3 Slot 2 Slot Name-> [ Take OFF / NAV
Fimware MJF_FW_3 20 3 Save g Direct¥ button

Keystrokes oN -~ W moe. | _Ia 16
Get from F55B R3 the Slot memorized values |

HAT E BEOV i and set these values as actual settings :I o7
o c| 2 ¢, CAR, |o g

Sound ON 0
p | BEY, |k |o A3
: ON

Light ON Y a9, |LShﬂ,.‘, |u 70 ¢

Now in next chapter we will explain all features include in the firmwares and managed
by the RS_HID_DEV_TOOL.

Note: in this chapter we include some partial screenshots of previous
RS_HID_DEV_TOOL versions; they have not been replaced because the
content shown is the same than later versions. However, remind this
firmware is only configurable with the RS_HID_DEV_TOOL v15 and higher.
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EMYCSA MJF_FW_F16-18 Firmware
RealSimulator [ pae: 2012-2022

Version: 3.01

PICTURE

LAST PUBLISHED FIRMWARE VERSIONS:

- FSSB-R3 Lighting: MJF_FW_F16-18_5_01_0.FSSB_R3
- FSSB-R3L MKII ULTRA: MK2 MJF_FW_F16-18_5_02_0.FSSB_R3

DESCRIPTION

Overview

This firmware includes support for FI6SGRH grips, FI8CGRH grips and TM compatible
grips being a solid attempt to unify the functionalities of standard MJF, BMS and AER
firmwares.

This is the more advanced firmware version and it will be the only firmware with
maintenance and future updates.

This firmware has only a hid device with the X/Y axes and 64 buttons. Programs like
MS Flight Simulator and DCS support more than 32 buttons in a hid device. Old
versions of Falcon BMS only supported a maximum of 32 buttons per HID, so if you
have installed an old program version, it will be necessary update it to the last version.

Other new feature included in this firmware is that it supports the new RealSimulator v2
grips with haptic feedback.
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This firmware MJF_FW _F16-18 will be the only firmware with maintenance
and updated in the future.

Modifications and new features included in firmware versions later than 5_00:

- Version 5 01 _O:

e Itincludes support for haptic feedback in RealSimulator v2 grips.

- Version 5 02 _0:

e Available only for the MKIlI ULTRA. It fixes some issues in TRIM and NASA
features.

When the FSSB-R3L has connected RS grips, the user has available 8 slots selectable
by the rotary switch and when has connected a TM compatible grip has 4 slots
selectable by the Special Modes Menu as with the classic firmwares.

In any way, if you are going to connect a RS grip to the FSSB-R3 Lighting this firmware
allows you to play without connection problems because the FSSB-R3L assumes all the
stick functions and the Bluetooth connection isn’t necessary. In fact, if you install this
firmware in the R3 Lighting, we suggest you remove the Bluetooth device from the
“Device and Printers” window to receive information from only the FSSB-R3 Lighting,
if not, you will receive information from two devices, the FSSB-R3 Lighting and the
Bluetooth grip device, and everything will be more complicated when configure the
simulation program.

This firmware is only configurable with the RS_HID_DEV_TOOL v1.15 and higher,
SO we suggest always install and use the last version.

In function of grip connected the RS_HID_DEV_TOOL will show more or minus
features enable.

e e

| = -

FSSB-R3L with a RS F16SGRH v2 grip FSSB-R3L with a RS F18CGRH grip
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FSSB-R3L with a TM compatible grip

As you can see, the new FSSB-R3 RH tab includes new functionalities as keystrokes,

macros, overlay generation and other new settings.

Every FSSB-R3L slot has the following settings:

HAT as POV or TRIM.
Sound ON/OFF

Light ON/OFF

DX Buttons ON/OFF.
Full Scale Control.
Roll Sensitivity.

NASA Roll Sensitivity.
Pitch Sensitivity.
NASA Pitch Sensitivity.
BFA Roll level.

BFA Pitch level.
Warning Sound Level

Keystrokes ON/OFF.

Roll Control Assistance (RCA).

Precision Mode.

DX Center Buttons (ON, OFF, COMP and DClick).
DX events and Keystrokes generation by pulses.
Additional slot change thanks to the Shifter and
Toggle functions.

Digital Mouse.

e Trim adjusts.

e Haptic.

13§ RealSimulator HID Device Tool V1.15.1

File Help
FSSBR3IRH FSSBRILH TUSBAR2 RUSBA FUSBA Magind &
BACKUP Slot 1

Firmware MJF_FW_5_01_0 Load
Keystrokes ON ON
HAT TRIM TRIM
Sound ON ON
Light ON ON
DX Button ON ON
FollSoae Cort s
Roll Sensibilty 3
NASA Rol Sensiilty +
Pich Sensibilty 2
NASA Pitch Sensiiity =
Roll Control Assistance (RCA) OFF OFF
BFA Roll level 5
BFA Pich level 5 Min

Precision Mode

e}
il
L
H
fe]
bl
el
@
<

0% | 1

DX Center Buttons
Waming Sound Level
Digital Mouse Switch
Digital Mouse Speed
Digital Mouse Button
Digital Mouse SimButton
Shifter Button | Paddle |3

Trigger 1

Paddle

Shifter Slot number
Toggle Buton
Toggle Slot Number
Hardware TRIM
Set Trim Button
Reset Trim Button

CTRIM |/
CTRIM |/

CTRIM
CTRIM

5
- - . 8
PRICCIE IR O D
z @
]I%IEEIEIIEH s

Haptic

Q

z
e}
z

Note: some of previous features are only available with the RS grips.

With this firmware the FSSB-R3L is a composite device with a Game Controller for the
DX axes and DX buttons, a Keyboard to send programmable keystrokes and a Mouse.
It is shown in the Devices and printers windows as a joystick named FSSB R3

Lighting.
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~ Devices (8)

Virtual 5 SCSI
Disk Device

~ Printers (3)

& ==

FSSB R3 Lighting Manufacturer: RealSimulator Category: Gal
Model: FSSB R3 Lighting
Description:  Professional Force Sen.

When you plug in the FSSB-R3L with this firmware installed to an USB port, the joystick
will be displayed in Windows and all applications that can handle HID devices, with the
name “FSSB R3 MJF SGRH”, as you can see in the next image in the Game
Controllers window.

Some operating systems do not change the name directly and you find
“FSSB R3 MJF J+B”, but after launch the RS_HID _DEV _TOOL with the
device plugged, the name will change to “FSSB R3 MJF SGRH".

Note: in this chapter we include some partial screenshots of previous
RS_HID_DEV_TOOL versions; they have not been replaced because the
content shown is the same than later versions. However, remind this
firmware is only configurable with the RS_HID_DEV_TOOL v15 and higher.

With this firmware installed you will see only one FSSB R3 MJF SGRH device. This
device will show the Roll (X Axis) and Pitch (Y Axis) axes, 32 DX buttons although it
has 64 buttons (it is a limitation of Game Controller tool of Windows) and the Point of
View Hat. If you want to check the non-visible buttons, you can use the
RS_HID_DEV_TOOL program.

‘7 FSSB R3 MIF SGRH properties X
#% Game Controllers =
Settings | Test
— These settings help you configure the game controllers installed on Test the game cortroller, i the controller is not functioning propery, it may
r; your computer. need to be calibrated. To calibrate it go to the Settings page.
Pues
Installed game controllers
Contraller Status 4
F55B R3L MJF 5GRH QK
X Aads /Y Fods
Buttons Point of View Hat
2000006000
( XA XX NN X N
Advanced... Properties . . . . . . . .
0000000
Cancel Booly

Now in next sections we will explain all features include in this firmware. First, we will
show them with a RS grip because it can manage all of them, and finally we will specify
the features that TM compatible grips can manage and how they do it.
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RS HID_DEV _TOOL and FSSB-R3L + RS Grips

There are two important concepts that you need to know before starting with the
explanation of how this FSSB-R3L firmware and RS_HID_DEV_TOOL work.

The first one is that the RS_HID_DEV_TOOL application can work in two modes
selectable by buttons: in Configuration Mode and in Game Mode. The active mode is
shown with a red box in the button of active mode and clicking on the other button
changes the mode.

B S
-
MACROS
Overlay Settings = [T
GameMede || - Loo_..
Conf Mode Angic B
G W] D Measures W Raw b

The Configuration Mode is the standard mode to configure the FSSB-R3L. In this
mode you can load a slot in the Active Configuration area, modify it, try it and when you
are satisfied with the settings to save it in the slot number that you want. In this mode,
when you change the slot with the rotary only change the information shown in the Slot
Configuration area. It is necessary press the Load button to pass this information to the
Active Configuration area to be effective.

The Game Mode simulates when the RS_HID DEV_TOOL is closed and changing the
slots with the rotary switch changes fully the active configuration. As you will be able to
see in next sections some features need this mode to work properly with the program
opened.

%% RealSimulator HID Device Tool V1,12 %% RealSimulator HID Device Tool ¥1.12
File  Help File  Help
FSSBRIRH FSSBR3LH TUSBARZ RUSBA FUSBA Magind & SpeedBrz FSSBR3IRH FSSBRILH TUSBAR2Z RUSBA FUSBA Magind & SpeedBrak
BMS433u1 St 2 5l BMS433ul (5\012 \ Slo
Fimware MJF_FW 3203 | (o _ Frmvare MUE_EV3 203 . g & On
Keystokes [ o on W [t Keystrokes oy oN (N
A A
& [ P
HAT POV POV HAT pov POV !
c| [ ol N
Sound ON ON 0 Sound ON oN ol 3
P P
Light ON ON Yl @ Light ON ON "I @
DX Button oN on P el ON ON Pl
DMS (FSC) - A DMSFSC) [y |12 A
Full Scale Control = S| [e Full Scale Control m = 44 5| [6
Roll Sensibiity | 130 |2 130k E Roll Sensibity [ 1301 | % 130b E =
NASA Roll Sensibiity | 100% |}3 ] NASA Roll Sensibiity | 100% |5 100 * ]
Pitch Sensibility : 350b ] Pitch Sensibilty 2 850k H
NASA Pitch Sensibil nE ) . 1 =
sy 1 wsnpen sty [0 ]2 o %
1 1
Roll Control Assistance (RCA) OFF OFF | Roll Control Assistance (RCA) OFF OFF 1
BFA Rol level : | BFA Rol level 3 Med =
BFAPIchlevel | Med |2 ] BFA Pich level 5 Med 7
Precision Mode | per o OFF 1 Precision Mode | gpp 2 OFF || 50% 1
C o}
D Center Buttons DClick DClick DX Center Buttons DClick DClick
Waming Sound Level Waming Sound Level % 207
Digital Mouse Switch Digital Mouse Switch 5 None
Digtal Mouse Speed Digital Mouse Speed : 1
Digtal Mouse Button Digital Mouse Button + Pinky
Digtal Mouse SimButton Digtal Mouse SimEltton 5 Left
Shifter Button None Shifter Button None | None
Shifter Slot number 1 1 Shifter Slot number 1 S 1
Toggle Buton | _Mone [ Nore ] Toggle Buton | None |2 None
Toggle Sict Number 1 Toggle Slot Number : 1
Configuration Mode Game Mode
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In this mode, the Load and Save buttons are disabled and the active slot information is
directly shown in the active configuration.

The second important concept is that you must know which configuration data are
stored and what is its location to understand how the application works.

The program saves the information in two places:

a) On the computer, in an .xml file, in the folder %APPDATA%\Realsimulator
Data\FSSB R3. Here, it saves the configuration settings, the keystrokes and the
explanations associated with all slots.

b) The device itself (in non-volatile memory) saves the configuration settings and
the keystrokes of all slots and the file name. Please, be aware that the device
does not save the explanations.

Now we can start to describe the connection between the application and the device.

As soon as the user launches the RS_HID DEV_TOOS or clicks on the tab FSSB R3
RH, the application fills the slot configuration data with the information stored in the file
FSSB_R3_BACKUP.xml. This file is an automatic backup of the information saved last
to the device or file. So, you can always recover the information.

Next, it checks if a FSSB-R3L is already connected to the computer by USB. If so, the
stick image changes to a colour representation and all the slots configuration data are
loaded from the FSSB-R3L.

As we explained above, the application loads all the slots information except the
keystrokes explanation from the FSSB-R3L, but as it loads also the .xml file name, the
application searches the .xml file in the data folder and extracts the Explanations data
from it. And finally, it fills the slots configuration data and displays the file name in the
left upper corner.

As the data stored in the backup file is the last saved, generally you don’t detect
changes in the presentation, unless you forgot to save the modifications in the stick or
in the file. In this case, load the backup file and save it on the computer and in the grip
with a name of your choice.

e L x WEr—

Loading data from the F1I6SGRH Updated info after loading

In the section “Load, Save and Print a .xml configuration file”, you will find more
information about how to save and load the configuration files.
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How this firmware works

From the point of view of FSSB-R3L, the RS grip is
a grip with buttons and hats and a rotary switch.

The Rotary switch is placed under the TRIM hat : f X

switch cap, as a black ring with rotary movement,
and it allows, with a single thumb movement, to
swap between the 8 configurable memory slots that
the FSSB R3L has, allowing to reconfigure your
whole system in a fraction of a second.

Users with a TM compatible grip have only four
programmable configurations and they can change
individual settings in the configuration by the SMM
(you can read information about in the section
“Connecting FSSB-R3L with TM compatible grips” in this chapter.

TRIM HAT
SWITCH

ROTARY
SWITCH

Now, with the RS grips (F1I6SGRH/F18CGRH) the concept is different. The SMM
launcher has disappeared and the user has 8 configurable slots, which allows him/her
to configure the settings for 8 different flight situations. For example, you can assign
one slot for an A-A combat, another slot for refueling, another for NAV, another for A-G,
etc. You can have up to 8 different situations. This is equivalent to having 8 different
joysticks, each one fitted for a different situation and the change between them is done
with a single thumb movement, reconfiguring the whole system in a fraction of a
second.

The user is informed about the slot active by the status LEDSs, the information is shown
in binary code.

Slot 1: off - off - off
Slot 2: on - off - off
Slot 3: off - on - off
Slot 4: on - on - off
Slot 5: off - off - on
Slot 6: on - off - on
Slot 7: off - on - on
Slot 8: on - on - on

Slot 2 Slot 6

The grip (F16SGRH/F18CGRH) information is sent through the 5-pin mini-Din
connector to the FSSB-R3L. It is only the 64 buttons status and the rotary switch

position.

The configurations you prepare with the RS _HID_DEV_TOOL are saved in different
memory areas, and they are accessed in function of what the device needs. The
working of these memory areas is explained below.

a) Instant area: this area always contains the information presently in use. It is on
volatile memory and it is loaded with the slot 1 configuration each time the device
is turned on.
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In normal operation (with the RS_HID_DEV_TOOL closed) you can change its
settings immediately with the rotary switch, selecting another slot.

When the RS_HID_DEV_TOOL is opened the user can change the settings of
this area with the buttons and numeric Up/down controls to configure it. Finally
with the Save button can save the configuration in the non-volatile area.

Changes with the rotary switch to change the active slot or Load actions
overwrite this area with the new information and non-saved info is lost.

Please, pay attention and understand the previous explanation, it is very
important to configure the FSSB-R3L.

b) Memory area: this area contains the slots information that can be used (in
normal operation) or shown and loaded/saved when the RS_HID_DEV_TOOL is
launched. This is on volatile memory and it is loaded with the information of the
flash area when the stick is turned on. This
information is always available to be saved it in the
Flash area, to be loaded in the selected slot of the
Instant area or to be saved in the selected slot of
the instant area.

»

c) Flash area: it is in non-volatile memory and it stores
the information to be loaded after the power is on.

This area is automatically updated when a slot
configuration change is done and saved voluntarily
with the Save button. The device beeps and lights
in green.

This area can also be modified voluntarily with the ; ;
keystrokes information after a change in this sy
information. At that moment, an alert button will
appear over the animated area to inform the user.

Let's see with an example the interaction between the different areas and the
notifications received when, for example, you modify the slot 7 to adjust the Roll
sensitivity to 75% and the DX button 0 with the keystroke “1”:

1. Launch the RS HID DEV_TOOL and select the “FSSB R3 RH” tab. Wait until

the system loads the configuration stored in the device.
(Instant = changed, Memory = changed, Flash = unchanged)

gl§ §
i
H

W =

|

2. With the rotary switch, change the slot to 7 and verify as the slot info is transfer
to the Instant area.
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3. Change the Roll sensitivity to 1,97 Ib

4. Click the Save button to pass the

(Instant = changed, Memory = unchanged, Flash = unchanged)

File  Help

BMS433

%% RealSimulator HID Device Tool V1.12

- X
FSSBR3IAH FSSBRILH TUSBAR? [FSEET TSR Thoind 8 SpeedBrake FI65GRH FIBSGLH FIBCGRH FIBCGLH
1 Slot Name-> [ Siot_Number_7 Explanation Names
Fimware MJF_FW/_3_fD | o1 Drectxuen 'h
s [a o M o] Jobmn | HED) Jo e | )
HAT TRIM TR Bl [ | Jo 7% | Jo 133% | Jo [, | o
= c| 208, o [0, o [39, o 500, o
Sound on o
oun ol = o 30 51
i oN
Light OoN id 200 %0, 5
X Ritton -

(Instant = changed, Memory = unchanged, Flash = unchanged)

%% RealSimulator HID Device Tool V1.12
File Help
FSSBR3RH FSSBRILH TUSBARZ RUSBA FUSBA Magind & SpeedBrake FIBSGRH FI6SGLH FIBCGRH F18CGLH

BMS433u1 Slot 7 Slot Name-> Explanation Names

Frmmere MIEFWA203 [ oag | [save | (pgy| DrectXbution

Keystrokes OoN on i o % | Jo [167% [ Jo 2% [

HAT TRIM P Bl [T | Jo 7% | Jo e [

. c| B o fe | o e,

Sound o on 9! oy Jo rige, | e o[

DXB:?M ON || o, | Jo 202 | Jo %aﬂ[

DMS(FSE = — Rl B Jo 27 | Je e [

Fu Soae Coreet |_%4_|E S| [E7%] Jo 2% | Jo mEo [

Rol Sersbity | 1971 || 130b il m o | o e, | Jo mmo, [

NASA Roll Senshilty | 100 % 100 % 0 - )
Piich Sersbilty | mani |12 = | [ ,”! !u e !ﬂ m,nl;

information from Instant are

a to the slot

memory in Memory area and in Flash memory. The device will beeps and lights
with the green light.

(Instant = unchanged, Memory = changed, Flash = changed)

133 RealSimulator HID Device Tool V1.12
File Help
FSSBR3RH FSSBRILH TUSBARZ RUSBA FUSBA Magind & SpeedBrake F165GRH F165GLH F18CGRH F18CG LH
BMS433u1 e 1F P 5203 Slot 7 Slot Name-> [ Siot_Number_7 Explanation Names
=T e g Drectxbuten
Keysiokes oy o -h W | Jo &% | Jo [32%,
0 o a
HAT TRIM TRIM Bl o Jo 7% | Jo e[
c| @, o [0, 0 340, |:
Sound 0
o FRERES o [18°% o [35%
Light Y| @, o3, o @[
DX Button
Pl e, o [21°% o [379%
DMS (FSC) = A
Full Scale Control - 5 (8 9% o [229 o 389,
- T
Roll Sensibity . % E| % o [B, 2 [33% I:
vestsst [ae e [we] g vor,

5. Now, click with the left mouse button in the text box of DirectX button “0” and
enter the number “1” in the window that appears. As soon as the window closes
and the keystroke “1” is shown in the text box a new alert button will appear over
the animated area.

6.

(Instant = changed, Memory = changed, Flash = unchanged)

'35 Reaimulitor HID Devce Tool ¥1.12 x
Bt selp
FSSORIFH FESERILH TUSBARZ FUSEA FUSBA Maghd dSpeedioke FISSRH FIESGLH FIECH R FIECH LK
i 1 St tome:> [Combate A Extarstion Haes
e WE LA [ | (G| ) Ovcttivton
Keysokes | oy = W v it o %, . e, .
e — | [, e |, -, .
= ¢ &, o e, o 39, o 0, .
Sored on o | ey [ = o o e, A
™ o on | e - o 1A o =0 -
OB ow on v E o @t o 37, « = 8
M5 S0 a4 B n 7 A . .
RS b : @ = @, s N —
Fol sertity [ 1308 | 3 D tad e, . 1, . 3
NASA Bl Seratity | 100% | 00 = o o e .
e o 8 (L) LN o % CICEN o 57°
NASA Fach Serabity | 007 |3 00 e, | o &, o @ - e,
LM o 77 o &, o (S0
o Cortrl ostarce (ICH) | OFF o [ o, o @, . @,
BrARlleel [ Med |3 ] e, | o, o Y, o €1,
BFAPIchlevel | Med |3 Med T, [ o B, o [, . @,
Precison Mode ey (507 3 |oFF | 50% 15, o 3, s, * g,
Ouran
OXCoterBtios | ON on
Wiaming S Level [ 807 |5 0 |
Digal Mouse Sodch | tore | Hone
Dt Mouse Speed | 1|+ 1 e PICH
DotaMasemn | W |2 w =T T
Dopa Mose Smbumen | Lot L Rax [ um
Yore 15 tone Pach 278
‘Shifter Siot rumber 1 + 1
Tooge Bukry |_Pine |+ .
Togge St bumber T
-
]
WicADS
Oreay Setrn
Gane Moo
.
e = Rom s
WV RosiSimul

If click over the alert button the modification will be definitively stored in the flash
area. The alert button will be deleted and a new beep and green light
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confirmation will be sent.
(Instant = unchanged, Memory = unchanged, Flash = changed)
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7. Finally, you should save the configuration in a file on your computer to restore it
when you want, or to share it with your friends. To do this, click File in the upper
menu bar and select Save to keep the file name or Save As to change it, and
press Save in the folder dialog to finish.

'%% RealSimulator HID Device Tool V1,12 33 Save FSSBR3 RH Conf & Keystrokes x
Eile | Help || « RealSimulator Data > FSSBR3 > v ®| | BuscarenFssBR3 p
1 Mew CulN TUSBAR2 RUSBA FUSBA Magind & SpeedBrake F16SGRH F16SGLH F18CG RH Organizar ~ Nueva carpeta =R
5 Qpen Cul+0 Slat 1 SotName> [Combate G W Eseeqipe | Nombre
° see cus o FPRAE T | [save | (g| Drectkbutton :Desnargas o

Desktop
vels = on on Wi, e o ®@am
B ill® 0 B @ BACKUPxml
&) Pt CtrlsP AT TRIM TRIM ;mgm @ vsizsoron
c 20, o Mdsica (@ FSSB_R3 BACKUP.xml
Exit nd ON oN 0| g . B Objetos 30
P ° .
Light ON oN ¥ - . B videos
T ‘i W10 Programas |, o >
o on PIBEl e
0
DMS SO [y iz A Nombre: B
Full Scale Control = sile% e Tipo: |FSSE R3 R file (XML) S
: o
NASA Roll Sensibiity = =l . ~ Ocultar carpetas Guardar Cancelar
——a L

g
The normal operation of the FSSB-R3L with the slots (with the RS_HID_DEV_TOOL
application closed) is simple and without complications, it is only necessary to change
the slot with the rotary and with that simple action to change the settings and
reconfigure the system operation. This way, the status LEDs show the active slot
number in binary and the active configuration is loaded in the Instant area.

Finally, just as when writing a letter, it is not necessary to save the file after each
character and you do not need to press the alert button to save in the flash memory
each time you change a data, it is only an alert box to inform you. Save from time to
time in order not to lose the changes.

Slot Configuration

As we have mentioned above, there are 8 slots configuration selectable easily through
the rotary switch action.

If you did not see the section “How this firmware works”, we suggest reading it to
know how to modify the settings and not to lose them.
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In every slot you can configure the following:

%% RealSimulator HID Device Tool V1.15.1

a) Analog settings: File  Help
FSSBR3RH FSSBR3LH TUSBAR2 RUSBA FUSBA Magind &
 Full Scale Control. Lo N
e Roll Sensitivity. on |
o ON ON
¢ NASA Roll sensibility.
. e HAT TRIM TRIM
e Pitch Se_nsmwty. . a | o
e NASA Pitch Sensibility. s [ON =
¢ Roll Control Assistance. DxBum  [oN oN
e BFA Roll level. Ful Scae Cortre : 44
. Roll Sensbity | 500 |2 5008 |
e BFA Pitch level. NASA Roll Sensibilty 2 T
e Precision mode. Pach Sensbity [ 5.05b |1 305 |
e Roll and Pitch Trim. S EEEE BT
b) Dlgltal Settlngs Roll Control Assistance (RCA) OFF OFF
BFA Roll level : [wn |
e Keystrokes ON/OFF. BFAPichlevel | Mn ||3
e HAT as POV or TRIM. el S ERIEY
* Sound ON/OFF DX Center Buttons ON ON
i nght ON/OFF Waming Sound Level = 80 %
Digital Mouse Switch None |15 m
e DX Buttons ON/OFF. et [ T8
e DX Center Buttons mode. Dotal Mowse Buton [ Tiooer 112 [Trggm 1]
° Warning Sound Level. Digital Mouse SimButton | Left }3 [k |
. ifter Button | Paddle | addle
* Keystrokes and Explanations I Dot
e Digital Mouse. Toggle Buton | Nore |2 Nore
H Toggle Slot Number 1 = 1
e DX events and Keystrokes generation by o MNOHE . I_Nﬁ
pU|SeS Set Trim Button CTRIM ||k W‘
e Additional slot change thanks to the Shifter i ] TR lfe
- Haptic
and Toggle functions. i’ % on
e Haptic.

Now we will explain in detail each setting.

FULL SCALE CONTROL (FSC)

This control allows adjusting the full scale of Roll and Pitch axes in four levels. The
indication is showed numerically on a textbox and the selection is done with an
Up/Down indicator.

= Buttens U
DMS (FSC) : m

° 44 FU” range iS 100% Full Scale Control 4:4
o g . R : Increase/dicrease full scale value b_
e 3:4. Full range is 75% NASA Roll Sensibilty =| 4:4 = SMM + DMS Up -
; . L ={ 3:4 = SMM + DIMS Right -

e 2:4. Full range is 50% Pitch Sensbilty % 2:4 = SMM + DMS Down b
: i - - =| 1:4 = SMM + DMS Lef -

e 1:3. Full range is 25% NASA Pitch Sensibilty : - eft .

This allows configuring different flight control’s response level for the same input signal
of force.

For example, if you select FSC to 2:4, now with the same force than applied in the
normal 4:4, you only get the 50% of signal. So, you improve the precision in
manoeuvres that need small and precise movements, as is the case of a refuelling.
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FSC=4:4 FSC =24

ROLL SENSIBILITY

This control allows changing the Roll axis sensibility in discrete steps from 1.30 Ib. to 13
Ib. The step value is not fixed; it is variable in function of sensibility value. It goes from
small values of 0,025 Ib. in high sensibility until big values of 2 Ib. in low sensibility.

The indication is showed numerically on a textbox and the selection is done with an
Up/Down indicator.

Full scale Lontrol L 1= -
Rol Sensivilty | 4331 {h-q [233b |
NASA Roll Sensibility 100 % :Tﬁcclif}: roll sensiblity
Pitch Sensibility 350 (H
To increase/ decrease in discrete values
NASA Pitch Sensibility -1 0% |H
1,30lb = 5SMM + TMS Up
4,331b = SMM + TMS Right
6,50lb = SMM + TMS Down
13,001k = SMM + TMS Left
BFA Roll level 1
BFA Pitch level Wi : To increase/ decrease step by step
SMM + Pinky + TMS Right/Left

Roll sensibility
Use Roll sensibility to adjust the maximum force level applied in stick (on roll axis) to
the maximum level of output signal. The default value of 4.33 Ib. is optimum for a
comfortable flight but always will be you own arm who tells you if it is the optimum or
you need change it.

NASA ROLL SENSIBILITY

This control allows adjusting different sensibilities for left/right Roll axis. The indication
is showed numerically on a textbox and the selection is done with an Up/Down
indicator. Values range from 50% to 200% in steps of 1%.

. r L Ik | 433D | - -
NASA Roll Sensibility [ 100% | [(1o0% | 100

Pitch Sensibity | 12551 | 45A Different sensibility for left/right ol
MNASA Pitch Sensibility 100 Suggested by Coolbho 3k
http:/fwww.realsimulator.com/FS5B_R3_Forum/viewtopic.php?f=128t=70

i I i

=

= right double sensible than left
= right equal sensible than left @
50% = right half sensible than left

BFA Rol level Nin

BFAPichlevel [ Min |2 [ Min | [ ob |

NASA Roll sensibility
A value of 200% means that right is double sensible than left.
A value of 100% means that right is equal sensible than left.
A value of 50% means that right is half sensible than left.

In FSSB-R3 forum “coolbho3k” explain the sense of this feature:
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In short, since your arm is stronger when pulling inward than outward, they
found that making rolling right more sensitive than rolling left was more
ergonomic.

Rolling left, the stick had a maximum displacement at 8 Ilbs. Rolling right, the

stick had a maximum displacement at 6 lbs. In the current FSSB firmware, you
can't set different values for left and right roll sensitivity.

So, if you want configure more realistically your stick select a NASA Roll sensibility of:
8/6=1,333 => NASA Roll sensibility =133%
but try to test between 110% and 133% and find the more comfortable value for you.

PITCH SENSIBILITY

This control allows changing the Pitch axis sensibility in discrete steps of 0.45 Ib. from 4
Ib. to 13 Ib. The indication is showed numerically on a textbox and the selection is done
with an Up/Down indicator.

P e R kY Uy e - 1w i
Pitch Sensbiity [ 8501 %ﬂ‘n] 8501
NASA Pitch Sensibilty | 100 % | 5[ Tlodify pitch sensibility

To increase/ decrease in discrete values

4.00lb = 5MM + Paddle + TMS5 Up

BFA Rolllevel Min = SMM + Paddle + TMS Right

BFA Pitch level Min

Al 4lr

0,75lb = SMM + Paddle + TMS Down
13,00lb = SMM + Paddle + TMS Left

To increase/ decrease step by step

SMM + Pinky + TMS Up/Down

Pitch sensibility

Use Pitch sensibility to adjust the maximum force level applied in stick (on pitch axis) to
the maximum level of output signal. The default value of 8.50 Ib. is optimum for a
comfortable flight but always will be you own arm who tells you if it is the optimum or
you need change it.

NASA PITCH SENSIBILITY
This control allows adjusting different sensibilities for fore/aft Pitch axis.

The indication is showed numerically on a textbox and the selection is done with an
Up/Down indicator. Values range from 50% to 200% in steps of 1%.

[

NASA Roll Sensibility $ [(100% | [(100% | 100
Pitch Sensibility 12551k |+ 8501b _ -
NASA Fitch Sensibility 100% 100% 100
MASA Different sensibility for fore/aftt pitch
Suggested by Ogamy Musashi
http:/fwww.realsimulator.com/FSSB_R3_Forum/viewtopic.php?f=1281=87
BFA Roll level i B 4
= fore double sensible than aft =
EFA Pitch level Min = foret equal sensible than aft 3
50% = fore half sensible than aft

NASA Pitch sensibility

A value of 200% means that fore is double sensible than aft.
A value of 100% means that fore is equal sensible than aft.
A value of 50% means that fore is half sensible than aft.
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Equal to in the previous NASA Roll adjust, if you want to adjust more realistically your
stick, adjust the NASA Pitch sensibility between a value of 110% and a 133% and
find the more comfortable value for you.

ROLL CONTROL ASSISTANCE (RCA)

This feature enables (ON) and disables (OFF) the Roll Control Assistance. The Roll
Control Assistance (RCA) intends to compensate in maneuvers with high angle of
attack and small or no roll, as looping maneuvers, the effect of roll introduced
“unintentionally” by the pilot during the maneuver execution. With this feature enabled,
the higher the pitch, the smaller roll value.

Yaw Sensibility S > U P >
Rol Control Assistance (RCA) OFF ,; ; ’_I:
S | ——
BFA Fol level Enable-"Disable Roll Control Assistance I
BFA Pitch level Med TS [ Ed ] r
- I SR p—— R SO p—— Ll 2 ’—

In the images below, you can see how the RCA modify the roll value. With this feature
enabled, a Roll value of 25% of input gives 0% of output.

" B - x B

RCA: OFF, Roll (X): 25%, Pitch (Y): 89% RCA: ON, Roll (X): 0%, Pitch (Y): 90%

BFA ROLL AND PITCH LEVEL

The Break Force Adjust (BFA) concept is to prevent small forces applied to the stick in
its neutral position, have a real manifestation in the axes measures and as result the
pilot has changes in the flight path that hi will have to correct continuously.

With this feature the pilot can select the BFA level separately in Roll and Pitch in four
steps from 0O to 10% of full scale and identified as: Off — Min - Med - High - Full.

The actual value is showed on a textbox and the selection is done with the Up/Down
indicator associated.

BFA Roll level Min Min
BFA Pitch level Min =T Increase/decrease BFA Roll Level

Decrease = Direct Paddle + CMS Left
Increase = Direct Paddle + CMS5 Right

BFA Roll level

We suggest select almost the “Min” option for a center value stable.

PRECISION MODE
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This feature allows the user to reduce the sensitivity of the axes to increase precision in
maneuvers that require precise or small inputs, such a refueling.

LA I T W e RE—

Precision Mode | ON OFF

The feature is activated through an ON/OFF button and the sensitivity reduction is
shown numerically in a text box and modified with an Up/Down indicator. “Trigger 1”
enables/disables the feature while it is pressed, i.e., if you enable this feature by setting
the button in ON, when you press the trigger button, the axes measures will be reduced
to the percent selected in the value textbox.

Let's see an example: if you place the button in the ON position, the value is 40% and
the axis X has a value of 10000. When you press the trigger, the value changes to
4000, when you release the trigger, the value comes back to 10000.

If the button is OFF, no change will be produced in the measures.

ROLL AND PITCH TRIM

Now it is possible to trim your plain like in the real world with this new feature.

Digital Mouse Speed 1 o | 1 [ Axes Measure

Digital Mouse Button WR = | WR

Absolute v [
i ] = : IT‘ Trim Roll 0 Roll X 32768
Shifter Button None = W{ o .
Shifter Slot number 1 | 2 m Trim Pitch 0 } itch Y

Toggle Buton | None I: ,W‘
[

Hardware TRIM | Both |[[2 m
Set Trim Button [ cpms |1+ m

Reset Trim Button Paddle | |2 W

MACROS

Ovenay Settings

Game Mode

Conf Mode

As you can see in the previous image the Trim system is composed by:

e Two text boxes to show the Roll and Pitch Trim values.

e The Hardware TRIM selector, where choose which axes will be trimmed. It has
the next options: None (no trim), Roll (only trim in Roll), Pitch (only trim in Pitch)
and Both (as normal trim in Roll and Pitch).

e The Set Trim Button selector, where you can select the center button switch to
set the actual Roll/Pitch values as Trim values. You can choose between the
next switches: CTRIM, CDMS, CTMS, CCMS, CWR, CNWS, CPinky and
Paddle.

e The Reset Trim Button selector, where you can select the center button switch
to set the trim values to cero. You can choose between the next switches:
CTRIM, CDMS, CTMS, CCMS, CWR, CNWS, CPinky and Paddle.

e And finally, the TRIM hat switch to adjust the trim slowly.

Let's see how the trim feature works. The TRIM system is enabled always the
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Hardware TRIM selects a different option than None. With the system enabled you can
use the TRIM hat switch to manual and slowly trim the attitude of your plain in the axes
selected by the selector or to apply a correction over a previous trim value.

Additionally to this previous way to trim the plain, there is another fast possibility to trim
the plain attitude; it is compensate with the force applied to the FSSB-R3L until get the
desired attitude and then press and release the selected Set Trim Button. When release
the button the actual roll and pitch values will be used as TRIM values of axes selected
in the Hardware TRIM selector, so after release the switch you can leave the stick free
and the FSSB-R3L will maintain the pitch and roll values saved.

As additional information, because is more comfortable, you can fly with the selected
Set Trim Button switch pressed, only it is important when you release it.

Every time you release the selected Set Trim Button the system will use the actual
values of pitch and roll as TRIM values, i.e. if we set a first trim of 50% of each axis for
example and after we need to do a second trim of 5% to correct it for a more precise
adjust, the final trim values will be 5%. To correct the adjusted TRIM values, you must
to use the TRIM hat switch.

To reset the TRIM values (or previously to do a new adjust) you must to use the Reset
Trim Button, it will set the Trim Roll and Pitch to zero.

KEYSTROKES ON/OFF

This feature allows enabling and disabling the keystrokes emulation. The selection is
made through an ON/OFF button.

IU3DAME MUIDA | FUJDA  MAYINU & JPECUDIdRE

BMS43307 Slot 1 Slot b
Fimware MJF_FW_3_20_3 Load | | Save Direci

Keystrokes ON

HAT POV| Enable/Disable Keyboard

o0 mE=tn

Sound ON ON

HAT (AS POV OR TRIM)

This button allows configure the HAT TRIM switch as POV (Point Of View) switch or
TRIM command. This allows the HAT during the use of the joystick, control the views in
POV mode or submit the information to 4 HID buttons for use as TRIM, which is its
function in real life.

| guuis T nny

Faddle + Finky Paddle + Pink Special Mode Menu

POV HAT

ON

Special Mode |'~_"|en|.|

HAT

Sound ON Switch between HAT as POV or TRIM 1 Sound
Light ON POV = SMM+TRIM Up
DX Button 0 4xDX Button = SMM+TRIM Down
5

OO
rrrrrrrrr

These DX buttons are the 20 (up), 21 (right), 22 (down) and 23 (Left).
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s FSSB R3 MJF properties X ‘& FSSE R3 MIF properties X
Settings [ Test ¢ Sattings | Test
Test the game controller. fFthe controller is not functioning properly, it may Test the game controller. I the controlleris not functioning propety, £ may
need to be calibrated. To calibrate it, go to the Settings page: need to be calibrated. To calibrate i, go to the Settings page
Pues Hoes
+ +
X Aods /Y Podis X Mods /Y Podis
Buttons Point of View Hat Buttons Poirt of View Hat
20000000 2000060000
00000 OGG (XA X X X N N N
90002000 O 000D OOPSO
000000 O® 2000000 OQ
Canel Boply Cancel Boply

HAT POV Up in POV mode HAT POV Up in TRIM mode

DX Trim buttons are always operatives whether the HAT button is on TRIM or POV
option; POV (Point of View) option is only operative when HAT button is on POV.

SOUND (ON/OFF)

Let you activate and deactivate the beep sound.

Sound o o GEF
Light ON'Enable/Disable Sound 0 Light ON
D Button on ON = SMM + Trim left B
OFF = SMM + Paddle + Trim left
DMS S0 24 7 :

LIGHT (ON/OFF)

Let you enable and disable the lights. This option is complementary and independent of
sound setting.

This feature is only available in the FSSB-R3+ Lighting. In the FSSB-R3 has not
functionality.

Light
D Button

DMS (FSC) . T
Full Seale Contral IL[ z

Light OFF
DX Button an Remove

EmovE:
ghts

DX BUTTONS ON/OFF

This feature allows enabling and disabling the DX buttons emulation. The selection is
made through an ON/OFF button.

If DX buttons is enabled, when you press a button, its DX button number is shown in
green. When disabled, it is shown in gold.
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e L 5 | - |EES |
- || -
DX buttons in OFF DX buttons in ON

Finally, the animated area with the joystick does not show actions when disabled.

DX CENTER BUTTONS MODE

The F16SGRH has hat switches in TRIM, RW, NWS, TMS, DMS, CMS, PADLE and
PINKY switches as you can see in the image below. Each hat switch has 5 positions:
up, right, down, left and center, although some of them don’t use the 5 positions. The
PINKY button has only left, right and center and PADDLE only center.

In the image on the right, you can see the DX buttons assigned to each hat switch
position or combination thereof.

DirectX button

0 % [Trigger 1 |s 116 2, [cms Down |e 322, [Trim C + Nose Down |o [4870, [WRC+UP o
il o |‘.’VR‘.’Veapnn release |a i |CIu|S Left |u 19, ‘Trim C + Left Wing Down |u 49 % ‘WRC +Right ‘u
2 0, [Pinky |o [80, [cwsc |o [32 0, [Trim C + Nose Up Jo 5070, [WRC+Down o
3 9, [Padde Jo [5%, [WrRUP | [25 2, [Trim C+ RightWing Down |s [51 %5 [WR G+ Left Jo
4 9, |NWS Nosewheel Steering |o [20 ®, |WR Right o [36 9, TMSC+Up o [52/%; [NWSC+UP 0
5 9, [Trigger 2 o [21°, [WR Down o [37°, [TMS C + Right o [53 %, [NWS C +Right 0
6 % |TM3SUp o[22 % |WR Left 9 [38 %3 [TM3 G+ Down 9 [54 %3 [NWS C +Down ]
7 9, [TMS Right o [23 %, [NwsUP 0 (399, TMSC+Left o [55 9, [NWS C +Left 0
8 %, [TMs Down o [24°, [NWS Right o [40°, [DMSC+Up o [56 %, |Pinky Left 0
9 U, |TMS Left o [25 ", [NWS Down o [41 %, DMS C + Right o [57 %, |Pinky Right o
70 ° [DMS Up o [26°, [Nws Ler o [42°, [DMS C + Down o [58 %, [Pinky C + Left 0
112, [DMS Right |o [27 9, [Trim Nose Down |o [@39, [oMsC+ Let o 582, [Pinky C + Right o
129 |DMS Down |n 289, |Tnm Left Wing Down |ﬂ 440, ‘CMS C+Up |ﬂ 60 %, ‘Tnm C ‘u
73 %, [DMS Let o [29°%, [Trim Nose up |o @570, [cws c + Rignt |o 6772, [oMsC o
74 9, [CMS Up |o [30°9, [Trim Right Wing Down  [& [46 2, [CMS G + Down Jo [62% [Msc o
15 9, [CMS Rignt Jo [31 2, [imC Jo [47 2, [cMsC+Lett Jo [63% | Jo
Ohdrid

The DX Button Centre feature allows selecting the operation mode of the center
position of hat switches. The selection is made through a button with four options: OFF,
ON, COMP and DClick.

In OFF mode, the center position of hat switches is disabled. As you can see in the
image below, all DX buttons related with center position of hats are removed (boxes in
grey) and when pressed, no DX button is activated. That’s why this mode is also named
Center removed mode.
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& RealSimulator HID Device Tool V1.12 - X
File Help
lagin P e
FSSBRIRH FSSBRILH TUSBARZ RUSBA FUSBA Magind & SpeedBrake F16SGRH F165GLH FISCGRH F18CGLH
BMS433u1 Siot 1 Slot Name-> Explanation Hames
Frmnare WIFFW3203 ['1oag | [Save | [ngy| DrectXbutton
fepdkeson on ) o Jo (56 | Jo [521% | Jo [ Je
P ) - ° O ) 0 o o
wr [ - e | Jo e | o 304 | Jo e |
Sound on oN 5 —t = = Co .
oun
| EE o [1@°% o [E% o [BT% o
e L o ') e, o @, o [, o 2, c
s OFF Pl B, o [21% o @@ o [53% °
DMS (FSC) A
Full Scale Control $| 6% o 20 o [ o [5%, a
Roll Sensiilty 0b | B, o, o [0, o [EE% o
NASA Roll Sensbilty e, o e, o [@°, o (560, o
Pitch Sensibil
ensibiity B, . e, o [T, o [57%, o
NASA Pich Sensbilty e, e « - = .
[iT%% o [27% o [, o &% s
Roll Control Assistance (RCA) . o @, o @, e )
BFA ol level 30, .|, o [0, o [B71% o
BFA Pitch level e, o H%, o EEC, o @, )
Precision Mode 159, o 370, o [0, o [E3% [
Qutput
DX Center Buttons OFF, ‘ ‘ I
Wanming Sound Level | 80% [} L

In ON mode, all center positions are enabled. This mode is also called Native mode

because all assigned combinations are available.

& RealSimulator HID Device Tool V1.12 — X
File Help
FSSBRIRH FSSBRILH TUSBARZ RUSBA FUSBA Magind & SpeedBrake FIGSGRH F165GLH FISCGRH F1BCGLH
BMS433u1 s WeF W 3 203 Set1 Slot Name-> Explanation Narmes
=0T Load || Save g| DrectXbuton
Keokes o o] W o] Jo 6% o | o |
AT POV ov Bl e [ Jo [7% | Jo 38 o 4812 [
Sound oN oN sl 2 = = =
p| 3% o [19% o [38°% o [51°%
ot L o Y1 @, o 2@, 5 (36 o [52°%
T ON P BT, o [219, o [379% o [53%,
asSE2 [ on i =5 o e =
Roll Sensibilty : E 70 o @0, o [\, o %
NASA Rl Sensibity o T, o @, o [T, . [0,
Pitch Sensbity | 1751 |} I o, o B0, o E% o 578,
NASA Pitch Sensibiity o i, o BE°s o EC, o A",
1%, o [27% o [43°% o [5%
Roll Control Assistance (RCA) oN oN fize, o [289, o 4%, o [60°,
BFA Rolllevel e, o [0, o 450, o 670,
BFA Pich level e, o 3, o @, . @,
Precision Mode fise, o BT, o @0 . &
Output
DX Center Buttons ‘ ‘ I
Warming Sound Level

In COMP mode, all hat switches work as in the real stick, i.e. when you press the NWS
switch only the DX button 1 is enabled, it does not matter in what direction you press

the hat switch, only the DX button 1 is enabled.

This mode is also named Basic because you have the standard 19 DX
compatible TM sticks, plus the 5-way TRIM hat switch positions.

buttons of

No valid DX buttons are shown in grey boxes.

In DCLICK mode, all center positions are enabled but they are available

%% RealSimulator HID Device Tool V1.12 - X
File  Help
FSSBR3RH FSSBRILH TUSBARZ RUSBA FUSBA Magind a SpeedBrake FIGSGRH FIBSGLH FISCGRH F180G LH
BMS433ul o WOF P 3.20.3 Slot 1 Slot Name-> Explanation Names
ST Load || Save g | DrectX button
Keysikes [ on on Wi 0 | Jo 176 | |o EEc | |o EB°, | Jo
et POV = | e [ o 7% [ o B30 Jo [ | Jo
Sound ON ON E 2| |+ R, Jo | o | .
Pl A% Jo FE2 | Jo e | |o S | Jo
Light ON ON Y| mme, o @07 o [@80% o [0, a
DX Button Pl g, o @70, o EE, o B, B
Ful S torl g § % o 2% o [3@°% o 5% o
Roll Sensibilty | B, o [0, o [ . B, o
NASA Roll Sensibilty E=e, = o E, . S, )
Pitch Sensibilty @, = o @0 e )
NASA Pich Sensibity I e, o B, o . . = )
1% o [27°% o [@81% o [58°% 0
Roll Control Assistance (RCA) oN oN o, o 30, o W, o E, N
BFA Rolllevel a0, o (8, o [E5]%, o B0 0
BFA Pichlevel e, o [30°, o [0, . 60, o
Precision Modz [15 % o [39 o [@7% o [63°%, a
Output
DX Center Buftons ‘ I
Waming Sound Level % %

by double
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button press. In the image below, you can see in orange color the center positions
available only by double click.

%% RealSimulator HID Device Tool V1.12 - X
File Help
FSSBRIRH FSSBRILH TUSBARZ RUSBA FUSBA Magind & SpeedBrake F165GRH F165GLH F18CGRH F18CG LH

BMS433u1 St 1 Erilme Explanation Hames
Fimware MIFFW_3.203 ' oaq | [ save DirectX button

|

.
|
.
% |
.
o

.

16

Jo 11672 |

|n 17nﬂ‘
Sound ON ON o [, |
Jo @2 |
o

19

Lght oN
DX Button ON

Fu ScdeCorie :

Roll Sensiikey [ 130 |} 130k

NASA Roll Sensibility 1 S

Pitch Sensibilty c 175

NASA Pitch Sensbity [ 100% |2

20°

o [2% o [38°% o[58

mourn  <won| Mrsa

1
2
3
]
5, o [A% o [379% o [839,
6
7
B

b
3
&

Roll Control Assistance (RCA) ON

BFARllevel | Med |13
BFAPRchlevel | Med |4

Precision Mode | [507] [+ % 150 o 3, o [@70, o [63°%

a
Output
DX Center Buftons
Waming Sound Level | 80% |} 0%

This mode corrects the problem of sending false DX buttons that happens in ON mode
when you press a combined action of center + another position. For example, in ON
mode, when you press to activate the DX button 48 (WR Center + Up), the DX buttons
1 and 48 are active. In DCLICK mode, with this sequence, you will only activate the DX
button 48. To activate the DX button 1, you need to press the button with a double click
and although you move the button with the center pressed, the status will not change.

DEmeo
955 9=
B &R
I
g 8

o e
= 3 =

o, o [30°, o [469, o [62°%

@
E
L

H

So, we suggest using mainly this mode.

WARNING SOUND LEVEL

Set the percentage for the warning sound level from 1 to 99% and calculated with the
actual sensibility and full scale control in 4:4.

In FSSB-R3 forum “Viggen” explain the sense of this feature:

| used to work as an instructor on a JAS-39 Gripen simulator. The Gripen fighter
has a much smaller centre mounted stick with the pivot sitting almost inside
your grip, which makes the pilot fly alot with the wrist (it's very nice). The stick
is force sensing but with a couple of centimetres displacement at the top. To
further enhance the pilots awareness of remaining performance (basically, how
much more is left to pull on the stick before you are at full aft position and the
FBW-system is giving you maximum available performance) there is a sound that
starts when pulling the stick roughly 80% backwards, and then another similar
but faster sound when pulling almost maximum. This is NOT connected to
amount of Gs or AoA, it is only a feedback telling you how much more you can
pull on the stick.

https://www.youtube.com/watch?v=B3giMFtbZbg

In this video at time 02:00 you can hear the sound that starts at roughly 80%
back pressure on the stick. It sounds like "dooot dooot dooot dooot...", if the
pilot would have pulled even more it would have sounded more like "dot dot dot
dot dot...."

So, when the forces applied to the flight stick achieve certain percentage the pilot
receive a feedback from the plane in the way of an aural tone like a warning to advise to
the pilot. In the same way when the applied force achieves the 100% the aural tone
changes to advise to the pilot hi is applying the maximum deflection to aerodynamic
control surfaces.
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https://www.youtube.com/watch?v=B3giMFtbZbg

We have implemented this feature in the FSSB-R3L with a warning sound and a light
blinking.

The level is showed on a textbox and the selection is done with the Up/Down indicator
associated, with range of 1% to 99% in steps of 1%.

Waming Sound Level {{17) 80
Meodify Warning Sound Level
2% to 99% are valid values
; 1% = Disable
O e —

Value in textbox of 1% disables the feature both for the warning and for the maximum
alarm.

Others values from 2% until 99% enable the warning alarm from that level until 99%
with a beep sound (dooot, dooot, ... ) and GREEM light blinking. In this case, when one
or both axes are 100% scale, the alarm of maximum is enabled and the sound and light
effects change to: beep sound (dot, dot, dot, ... ) and RED light blinking.

KEYSTROKES AND EXPLANATIONS

With this firmware the FSSB-R3L is a composite device with a Game Controller for the
DX axes and DX buttons, a Keyboard to send programmable keystrokes and a Mouse.

We have seen before how to configure and adjust the DX axes and buttons of Game
Controller, now we will see how to configure the keystrokes and later we will see how to
configure the mouse. The program window has an area reserved for this purpose where
you can configure the 64 keystrokes of each slot.

In the picture below, you can see in the squared area in red the controls allowing to
configure and manipulate the keystrokes. The information shown changes in function of
slot selected; in the picture, the Slot 1.

%% RealSimulator HID Device Tool V1.12 - %

File Help
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NASA Rol Sersbilty | 100% || [z | a0, o 30, o [80°, o 1560, o
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ersiity | 1750 175k g1, o [359, o [47% o [71° ‘
e o [27% o [43% o [59% °
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el

e | P [ 1 [

In the left upper corner of the squared area is the Slot Name field (“Combate AG” in the
picture), where the user can write the slot name, so it will be easier to remember the
slot function. To modify the content, click with the mouse on the text box and write the
description you want.

NOTE: remember that each time you change a parameter, it is immediately active and it
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is saved in volatile memory, but it is only saved in flash memory when you press the
alert button (for a more detailed explanation, please visit the section “How this
firmware works”) and it is saved to a file when press File > Save. As said in other
sections of User Guide, remember to save in both parts regularly.

To the right of the Slot Name text box, you can find the “Explanation/Keystrokes” and
“‘Names” buttons. The first one allows changing the keystrokes text boxes information
between keystrokes and explanations, as you can see in the image below. Pay
attention to this button, because it indicates the option to show if pressed, no the actual
option shown.

Slat Name-> |Take OFF # WAV | Explanation Mames Slot Name-> |Take OFF £ NAV | | Keystrokes I Mames
5 Direct X button 5 Direct X button
i o o | [0 [16 %, [Down, |o B0, [t - [pNE s [16 °, ICPDCSDN |o @20, [ATc
P [1 % [0, \u]w"u\Leﬁ, o oo w B [7 2, [cearroggte o|i7 ¢, [icPoCsRn o [33% [
c| [2 9, |LAtLp, Jo [189, | lo 380, ]e. [c| [2 o, ParkingBrk o[B80, [~ o [32s, [Ete
8 3% [k |o 18 %, [LshitLAUp, |o 351, E S 3 %, |[BRAKES |o 18 %, [ThrotlestoUp o [35 2, [Fi
Y @, [Lsnt, |0 2000, | |o 8% ke Y @, [Nws o [20%, [— o 389, [icF

Keystrokes text box with Keystrokes info Keystrokes text box with Explanations info

In the explanation information box, you have a place where you can describe the action
keystroke assigned in the game.

The second button, “Names”, allows, while it is pressed, to show the position where
each DX button is placed on the stick. So, in an easy and quick way, you can check to
which button you are assigning the keystroke.

If you want to maintain shown the Names info after press the button, press at time with
the two mouse buttons (left and right); to finish the presentation press the
Explanation/Keystrokes button.

Slot Name-> [Take OFF / NAV | | Keystrokes
5 Direct button
W 10 o, Trgger |o [16 2, [CMS Down |o [32 9, [Trim C + Nose Down |o [2g9, WRC+UP o
Pl [1 °; |WRWeapon release a] 1% |C|'v'|5 Left |a 3% |Trim C + Left Wing Down |a 49, |WRC +Right |a
c| 2 o, |Pinky o 130, [cusC |o [34's, [Trim C +Nose Up |o 505, [WRC+Down |a
S| @2, [Paddie |o 1879, [WRUP |0 [35 2, [Trim € + Rightwing Down |s [51 °, [WRC +Left o
Y| [& 9, [NwS Nosewheel Steering |o [20 %, [WR Right |o 3872, [TMS C+Up |o [527, [NwsC+UP |a
Rl 5% [Trigger 2 |o [21°2, [WRDown |0 [37 2, [TMS C + Right |o 1532, [nws C + Right |a
S | 6% [TMSUp [0 [227, |WRLet |0 [382, [TMS C+ Down |o [542, [NWs C + Down o
g e, [TMS Right |o 237, [NnwsUP |o [3972, [TMS C+Lett |0 [55 2, [Nws C+Left |a
8 °; [TMS Down o [24 %, [nws Right o [40°, [DMSC+Up o [56 %, |Pinky Left o
5 %, [TusLeft o [25 %, [NWS Down o [41°, [DMs C +Right o [57 %, [Pinky Right o
10 7, [DMS Up |o 267, [Nws Let |o 422, [DMS C + Down |0 [58 7, [PinkyC +Left |a
11 2, [DMS Right |o [27 2, [Trim Nose Down |o 437, [DMS C+ Left |0 [59 2, |[Pinky C +Right o
12 7, [DMS Down |0 [28 2, [Trim Left wing Down |o [4277, [cMsC+Up |o [60/%, [TimcC |a
13 9, [DMS Left |0 [29°2, [Trim Nose Up |0 [45 2, [cMs C + Right |o [61 9 [DwscC o
14 7, [cus Up |o [309, [TimRightWingDown |0 [46 %, [CMS C + Down |o 627, [TMsC o
15 9, [CMs Right |o [at 9, [Timc |o 472, [cMsC+Let o [639% | |o

So, for example, with the

Release” button, the stick will send the keystroke

DX button 1 that is enabled when you press the “Weapon

Toggle” in the simulation game.

“ ”

g,

the key assigned to “Gear

To assign a keystroke to a button, first choose the slot where you want to place the
keystroke action. In our example, we’'ll use slot 1. Second, choose on the stick the
button that will send the keystroke. For an easy location, press the chosen button and
see what DX button is activated. In this example, we choose the DX button O (Trigger
1).
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Next, with the button “Explanation/Keystrokes” in Explanation, click the text box
assigned to the DX button lighted and a new window will be displayed to enter the key
codes sequence.

a5 InputKeyScan >

Actual Key Code Empty
LNVim Macro RWin
Press new Key Code | |

BEEEN [ CeR | O

Trigger 1

In the window, you find information about the Actual Key Code assigned to the DX
button, the standard buttons “CANCEL” to cancel the action, “CLEAR” to clear the text
box content, “OK” to accept and validate the key codes sequence, two buttons “LWin”
and “RWin” to manually enter theses key codes if they are necessary because some
keyboards don’t have these keys, the button “MACRQO” to assign macros (keystrokes
sequence) previously filled, the text box where you can enter the key codes and in the
lower area, the name of button written in bold.

The text box accepts up to five keys and a modifier that can be composed by none, one
or a combination of these 8 keys: LWin, RWin, LShft, RShft, LCtrl, RCtrl, LAIt and
AltGr. Although normally we only use one key, the program and files where you save
the configuration can use two keys, the rest are ignored.

To enter the key codes, press the key sequence you want to compose the keystroke
event and always maintain one key pressed, because the sequence is finished when
you release the last key. In our example, we press the key “Left Shift” and the key “A”.

a5 InputKeyScan X

Actual Key Code Empty
LAVirt Macro | | /RWir
Press new Key Code LShft A,
P ClcAR Lok
Trigger 1

Finally, press “OK” to validate.

With some keypad code sequences, it can be necessary to first press the
keypad key and the modifier afterwards.

When the window closes, the key codes entered appear in the keystroke text box, as
you can see in the picture below.
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To enter the explanation of this keystroke, press the button “Explanation/Keystrokes”
to change it to Keystrokes and then click the keystroke text box where you entered the
key codes and write the comment you want. The explanation info is not necessary, it is
only a help to remember the keystroke action.
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Finally, you can check the keystroke operation. For that, click the CLEAR button
associated to the Output text box to clear its content and press the “Trigger 1” switch
in the stick and check that the key codes entered are shown in the*Output” text box.

To send the keystrokes, it is necessary to have the Keystrokes button ON. If at any
time the keystrokes are not sent to the Output text box, please check this.
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To facilitate the manipulation and relocation of slots keystrokes information (no slot
configuration), the program includes four buttons: SWAP, COPY, PASTE and CLEAR.

SWAP button allows, like its name says, to swap the actual slot configuration with
another one. The selection of slots is made with a new window that is displayed after
pressing the SWAP button.

g5 SwapMemonySlot H

-

SWAF Slot 1 with 2 |%

Clicking on the Up/Down indicator, select the chosen slot and after pressing “OK” the
information is swapped.

The COPY and PASTE allows doing the standard actions of copy and paste with the
slot data. To copy a slot to another, select with the rotary switch the source slot and
click on the COPY button, then select the destination slot and click on the PASTE
button.

Finally, the CLEAR button clears all the keystrokes, explanations and slot name of the
active slot. After pressing, a confirmation window is shown. If you click YES, all fields
are cleared.
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| This action will clear the actual slot
ARE YOU SURE?

IMPORTANT: Key codes input in the InputKeyScan window is made
according to the key map of USA keyboard, this is used in the games to
assign actions to keys. Below is an image of this US key map.
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And here, as an example a keyboard map of DCS for the A-10 Warthog.
Keyboard Map DCS A-10C WARTHOG
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As you can check, both key maps have the same keyboard symbol layout, so users
with this keyboard have the keys in the same place than the game keyboard map. But
users from other countries with keyboards with other layouts will need to use the USA
keyboard template to find the place of some keys.

For example, Spanish users with the keyboard layout below, when they want:
- to generate the “Track IR reset” action, they need to press the key “©” to generate
the keystroke ““

- to generate the “Slew up” action, they need to press the key “N” to generate the
keystroke “;” (semicolon).
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In conclusion, all you need for a correct operation is the keyboard map of the game or a
USA keyboard layout printed and you can press on your keyboard the key of the game
key map although it is different. Here you have a link to download and print the USA
keyboard layout:

https://en.wikipedia.org/wiki/British _and American keyboards#/media/File:KB United States-NoAltGr.svg

MACROS

Macros are sequences of keystrokes and delays that can be activated to help with
repetitive tasks or to replay sequences that are long or difficult to run.

In the previous section, we have already mentioned the macro function when we spoke
about the MACRO button in the Input Key Scan window. There you could only assign
a macro to one DX button. Now we will see the complete sequence with the macros
creation, assignation and execution.

To create or edit a macro, press the button MACRO and a new window will be shown.
]

ROLL

Angle =
Adiust m] DX Measures 5] Raw Measures

WWW RealSimulator com
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The system allows configuring up to a maximum of 10 macros (0 to 9) selectable with
the numeric Up/Down control Macro Num. Below the numeric control, there is a text
box where the user can write a title to easily remember the macro function.

Each macro can accept 20 configurable events and each event can use a Key code
and a Delay in 1/10 seconds during which the keystroke will be sent.

Unlike the key codes entered in the main window for each DirectX button, here each
text box of key codes can store only one key and a modifier that can be composed by
none, one or a combination of these 8 keys: LWin, RWin, LShft, RShft, LCtrl, RCtrl,
LAIt and AltGr. Also, the key code text box can store a PAUSE; this allows you to
configure standby times without sending keystrokes.

The macro sequence starts when you press and release (with the release action) the
button to which you assigned the macro and finishes when the system finds the first key
code text box empty.

Let's see how this works with an example. Suppose you want to create a macro to
perform an “Example action”, assigned to the macro number “0” and that consists of
sending keystrokes “A”, “B” and “C” and between first and second event the simulator
needs at least 2 seconds to execute the “A” action. The macro configuration would be
the following:
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We have assigned a time of 1/10 seconds as time to send each keystroke. Also, you
can see you forgot to include the time of 2 seconds the simulator needs to execute the
keystroke “A”.

To solve this problem, you can use the extra actions assigned to the right mouse
button: Insert, Delete and Exit. So, put the mouse over the text box of key code 1,
where the “B” key is and after right-clicking, select the Insert option.

gl Macros et ol Macros =
Macro Num ©° = Macro Num ° =

|Examp|e action | |Example action |
Pos  Key Delay 1/10s Pos  Key Delay 1/10s

v (3 [z T (3 B

1 |b, T ' |: 1| E

2 |: Deléte - 2 |b- | ! -

N - : 3 [, NE

o | Jam? e | |

Now press the text box to enter the PAUSE, and set the delay time to 20.

o InputKeyScan > % Macros X
Macro Num ¢ =

Actual Key Code Pause, |Examp|e ~ction |
Pa% (i RWir Pos HKey Delay 1/10s
0 |a E
Press new Key Code pa vy | T i
BEESERN CefR 0K 2 o I
3 e N
| e

With the macro configuration finished, it is time to test it. For this, you can directly close
the window because the system saves the configuration automatically.

To test it, assign the macro (remember macro number 0) to the Trigger 1 button. For
that, click over the text box of DX button 0 and the InputKeyScan window appears
where you can press the Macro button. A new window with numbers (named
NumKeyPad) is shown to enter the macro number (number 0).
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When you click “0”, all windows are closed automatically and the text box assigns the
“‘MACRO,07, as you can see in the picture below.
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Now, it is time to test the macro. For that, press Trigger 1 (DX button 0) and verify the
sequence and times in the output window.

Output
ABL,

Press Button

»
>

1/10s

Finally, the Macros window has two buttons identified as SAVE and LOAD, to save and
load the macros configuration to/from a “.mac” file. This allows you to reuse your macro
configurations.

62/110




ol Save FSSB R3 and Grip Macros
1 | <« RealSimulator Data »>

Organizar »  Nueva carpeta

"
@ OneDrive Nombre

20

0 Este equipo
Dec

& Descarges

FSSBR3 » ~ o

X 85 Load FSSB_R3 and Grip Macros

« RealSimulator Data »

Nueva carpeta

A Nombre

20
Doc

FSSBR3 » ~

@ xml

[ Desktop [7] AER_FW_102_2F5SB_R3
] Documentos [7] AER_FW_2 00_2.FSSB_R3
=] Imagenes (@ BACKUP.xml

D Musica [ BMs_Fw_1.03 2F55B_R3

J Objetos 3D [ eMs_Fw_2_00_2FssB_R3
B Videos (@ BMS433ulxml
. Bl Objetos 3D (@ FSSB_R3_BACKUP.xml
e v < > B videos [ LCILFW_1.02_2FS5B_R3

Nomre: | IETREETFNINEE - 2 W10_Programas [ LCLFW_2_00_2FS5B_R3
o v <

Tipe: | Macro file (*.mac) v

Nombre: ‘ MacroDefault.mac

A Ocultar carpetas

Save file dialog Load file dialog

DX EVENTS AND KEYSTROKES GENERATION BY PULSES

This new feature aims to generate events in a cadent manner following the ON/OFF
time pattern defined by the user while the button is pressed. It allows to automatically
send pulses instead of an ON signal while the button is pressed.

As a result of this feature, the DX button state will be pulsed and if you fill the key code
text box with some key, the keystrokes will also be sent as pulsed with the same
cadence that the DX button.

An immediate functionality for this feature could be turning a rotary switch in the
simulator. Without this feature, you would have to press intermittently the button to
generate the successive pulses for each rotary step, but with this feature you only need
to press the button and release it when the rotary is in the desired position.

To configure it, press on the DirectX button that you want to configure and a
configuration window is shown. There, we will configure the three following parameters:

e Pulse Width: time in 1/100 seconds that the DX button state will be ON. Values
go from O to 100.

e Pause: time in 1/100 seconds that the DX button state will be OFF after the ON
state. Values go from 0 to 100.

e Limit: maximum time in 1/100 seconds that the sequence will be repeated, as
long as the button is pressed. If value “0”, it will be repeated until the button is
released. Values go from 0 to 100.

This DX button configuration is independent for every slot, i.e. you can configure a DX
button as a pulse system in a particular slot and as a standard button in another slot.

Ol Kl

Pulse Width g |CIIII'I'I|:IE|tE.' AG | E:q:lléll'l ol Input Width and Pause >
i utton
5 Values in 1/100s
w .-'!'., @ g a Pulse Width Pause Limit
A — I 1 10[
a
P o 17 "y Old=0 Old=0 Old=0
i ]
Pause —
C | b o (189, ] _____JECCIN
O Trigger 1
5| @re, | la [19 9, 99

As you see in the previous images, we have configured the Direct X button “0” of slot
number “1” to send up to a maximum of two pulses of 0,01s, with a spacing of 0,04s, if
the button is pressed almost 0,1 second (10 x 1/100 seconds). If we release the button
before finishing the sequence, it is cancelled.
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Let us see the sequence when we press Trigger 1 (button 0) more than 0,1 second and
the sequence when we release before the time limit:
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PULSE
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>
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n

m
PULSE
PULSE
PAUSE

»
»

1/100s

SHIFTER AND TOGGLE

These two new functions allow to change the active slot to a predefined slot through an
activation of a previously assigned button, without the use of the rotary switch. To do
this, there are two modes: Shifter and Toggle.

In the Shifter mode, the new slot will be active only while the associated button is
pressed. When it is released, the slot automatically returns to the previous slot.

In the Toggle mode, the new slot is active from the moment the associated button is
pressed until the associated button is pressed again. In this mode, if, while the new slot
is active, the user manually changes the slot with the rotary switch, the toggle function
is cancelled.

As the execution of these functions entails the change of slots, it _is_absolutely
necessary to change the mode to Game mode (you can find more information about
this mode in Connecting RS_HID_DEV_TOOL and FSSBR3L+F16SGRH section of
this chapter).

Lo
Shifter Buttan = MACROS
Shifter Slot number 2 155 Sk
" I_>I Game Mode I
Toggle Buton - Corf Mode
Toggle Slot Number =

As you can see in the previous image each function only has two settings to configure
it:

e The Shifter/Toggle Button: here, the user must select through the up/down
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selector the associated button that will change the slot. We can select as
launcher button between: None (if you don’t want to use the feature), Triggerl,
WR, Pinky, Paddle, NWS and Trigger2.

e The Shifter/Toggle Slot Number: here the user must select through the
up/down selector the new slot number (1 — 8).

DIGITAL MOUSE

A new feature has been added to the device, a digital mouse. It allows moving the
cursor in the simulation game to execute actions and improve the VR experience.

Ty 2Uuna Lewvel (T 1]

Digital Mouse Switch ] M

&
4

[

Digital Mouse Speed

Digital Mouse Button | Trigger 1 Trigger 1

Digital Mouse SimButton

[T PR T TR Mearma

As we can see in the previous image, this feature is configured by four settings:
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e Digital Mouse Switch: it allows to choose a 5-direction switch to move the
mouse. You can select the switch between: None (if you don’t want mouse),
TMS, DMS, CMS, WR, NWS, Trim, and the previous switches with the center
pressed: CTrim, CTMS, CDMS, CCMS, CWR, CNWS.

e Digital Mouse Speed: to select the mouse velocity in the range from 1 to 16.

e Digital Mouse Button: to select the button you want to use as a mouse button.
You can choose between: Trigger 1, WR, Pinky, Paddle, NWS, Trigger 2,
CCMS, CTRIM, CDMS, CTMS.

e Digital Mouse SimButton: to assign the mouse click button. You can choose
between: Left, Right and Middle.

HAPTIC

H - i OFF |50 Bl Oa |
This feature allows creates a physical e CT;],M%‘
feeling by vibration that the user can e [ CTRM |
perceive and associate to different Dota Mouse Swich [ Nre_| ON

Digital Mouse Speed

situations. Dt owse Bt
Digital Mouse SimButton

. . . . . Shifter Button
This haptic vibrational feedback is only Sttr St e
available in the Realsimulator v2 grips. s

Hardware TRIM [ 4
Set Trim Button

At this moment, the feature is already f :
associated to the warning and maximum i - <=
force signals, by generating two continuous vibrations of different levels. This feature
complements the existing Light and Sound features and offers a clear feedback to the

VR users.

Remind this option is only available with v5 firmwares managed with
RS_HID_DEV_TOOL v15 or higher.

Other Features

The “FSSB R3 RH” tab of RSHID_DEV_TOOL offers other extra functionalities
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independent of slot. These are:

Neutral Position Adjustment (NPA).

Angle adjust.

DX/Raw measures indicators.

Overlay.

Documentation.

Load, save and print a .xml configuration file.

NEUTRAL POSITION ADJUSTMENT (NPA)

This is a feature with no access from the RS_HID_DEV_TOOL, but very important
because it let you at any time, even in flight time, adjust or compensate any possible
physical distortion in the gravity vector over you FSSB R3L.

The sequence to launch the Neutral Position Adjustment is:

Trigger 1 + NWS Center

After press the buttons sequence and during the adjust time, the base will sound an
intermittent beep and a green light will flash (if they are enabled). Please, release the
grip during this time and don’t move the FSSB-R3L.

When the sequence finishes, you will receive a long beep and the green light will turn
off and the X/Y axes must be correctly centered.

ANGLE ADJUST

This feature allows adjusting the angular misalignment between the Y axis of joystick
and the Y axis of cockpit that occur when the joystick is mounted in central position
(between the legs). In this position is necessary turning the stick to ergonomically
access with the buttons, switches and hats, but as the union R3L base and stick is rigid
and don’t turn, it is necessary turn the base and then a misalignment occurs.

The setting range is from -90° (left) to 90° (right). The values are adjusted using the
numeric Up/Down indicator in increments of 1° or directly with the slider. The
visualization of the angle is done in the textbox numerically and in the X/Y graph by a
gray circle and a gray rotary arrow. Each time the Angle Adjust changes the joystick
send a beep sound and a blue light signal (only available in the Lighting version).

Sl

:
Angle Adjust

Suggested by:
PeCa_Chuck
AzE

Angle
Adjust

Let’s look at an example; suppose we have our FSSB R3L installed in central position
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and we have rotated the base for a comfortable access to the buttons stick. Now apply
force to the stick according to the Y axis of the cabin, or towards our chest or moving
away from it perpendicularly. In this way, we will get an answer in the X/Y graph as
image below left. More a less, we can estimate than the misalignment is around 20
degrees, so we set the Angle Adjust to -20° and try again the same movement and now
we get the image below right, verifying the misalignment problem is fixed.

[o]E [20]
/ *
»
»
Angle Angle
Adjust Adjust

DX/RAW MEASURES INDICATORS

We have included two check boxes under the X/Y graphics to display both values. The
active option is shown in red color.
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As we mentioned previously in this User Guide, this device does not need calibration, it
is done in the factory and saved internally in the device. Windows must work with the
default calibration and users must use the RS_HID _DEV_TOOL to modify the settings
as sensitivity, auto zero, dead zones, etc. if necessary.

Clicking on the check boxes, the user can verify both measures are equal, if not, a
calibration has been done and the user must delete it and put the default calibration.

OVERLAY SETTINGS

A new feature has been implemented in the RS_HID_DEV_TOOL, the possibility to
show the name of the active slot over the program window that you want and/or hear
the slot name through speech synthesis. This allows you to know at any given time
which slot you have selected without looking away from the screen, so no need to look
at the Status LEDs in the F16SGRH. This feature is named Overlay and you can
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access it by clicking on the button Overlay Settings.
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As we explain previously the RS _HID DEV_TOOL has two working modes:
Configuration mode and Game mode. We suggest to change the mode to Game
before clicking the Overlay Setting button, so everything will work properly and we

won’t need to return to the main window to change the mode.

After clicking on the Overlay Settings button, a new window appears:

Show Time /Sa $

v [ Voice Oveday
[] R3L RHW. Sound [] Display Overay

o) RS Overlay Settings — *
Text position in window Program Name

O O O 5 [Falcon BMS |

f

O O O |a |Prepar3D |

I-|I |Dig'rta| Combat Simulator |

O = ? |n0‘tepad |

Slot number 2 |DCS |

Siot name | Take OFF / NAV | | |

Mode | Hold |

|

|

|

The window allows to configure the next settings:

Text position in window: 9 check boxes allow to select the position where you
want the slot name to appear (Up left, Up centre, Up right, ...... , Down right).

Default: button to set the Program Name list to default names.

Program name: a list of 10 text boxes to be filled by the user with the program
names you want to use with the overlay function. The name to write in the text
box is the “process name”, which is not always the same shown in the window or
in the Task Manager. For example, in the Spanish Windows version, the
“notepad” program is shown as “Block de notas” in the Task Manager and in the
program window.

When the RS_HID_DEV_TOOL program searches programs from the list to
overlap, the order is from up (first one) to down (last one) of the list and when a
program from the list is detected as working, its text box colour changes from
background color to orange as you can see in the picture below with the notepad
program.
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Slot number and Slot Name: show the slot number and slot name of actual
active slot.

Mode: this button allows selecting if the overlay will be shown permanently
(“Hold”) or by the selected time (“Time”) in the Show Time/Sg text box.

Show Time/Sg: this text box shows the seconds the overlap will be shown after
a slot change. The number of seconds can be changed with the numeric
up/down selector associated.

Display Overlay: this check box enables/disables the overlay image over the
program window when the program from the list is working and it is detected.
Here you can see a screenshot of notepad with the overlay showing the slot
name of slot 1.
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Voice Overlay: this check box enables/disables the speech synthesis to read
the slot name. This feature is not associated with the program detection. If it is
enabled, you will hear the sound on the speakers or headset each time you
change the slot.

R3L RH W. Sound: this check box enables and disables the aural tones
reproduction: warning (dooot, dooot, ... ) and alarm (dot, dot, dot, ... )
associated to the Warning Sound Level setting of FSSB-R3 Lighting Right
Hand. The tone volume is controlled with the upper track bar.

This feature is not associated with the program detection like the Display
Overlay. If it is enabled, you will hear the sound on the speakers or headset
each time you reach a warning or alarm level, and it is reproduced independently
of the sound of R3L, controlled by the Sound setting.
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The actual version of Display Overlay is shown only over programs in window
mode, not over programs in full screen mode.

RS_HID_DEV_TOOL v15 fix the problem of not to save the selected options
of RS Overlay Settings window.

When the RS Overlay Settings is configured and you click on the Display Overlay check
box to show the Overlay, you can minimise the window to have full access to the game.
With this action, the main window of RS _HID_DEV_TOOL will also be automatically
minimised.

Finally, the configuration shown in the RS Overlay Settings window is automatically
saved in the folder “%APPDATA%\Realsimulator Data\FSSB R3\” with the same name
as the .xml configuration file and the extension .GamelList.

DOCUMENTATION

The program includes a direct and quick option to access the User Guide. For that, click
Help in the upper menu bar and select DOC to directly access the AppData folder
where the user guide is stored.

[ %% RealSimulator HID Device Tool V1.12 - X

File [ Help |
FsS DOC TUSBAR2 RUSBA FUSBA Magind & SpeedBrake F16SGRH F16SGLH FI8CGRH F18CG LH
B Baseur,. Sat Sot Nare> o] i
MIFPWI203 g | [ save g DrectXbution
Keystrokes oN o \:‘ 0 [A | e, | Jo [@20% | Jo [a8 % | Jo
HAT TRIM TRIM | Jo 7 | Jo 339 Jo [@sie, | Jo
Sound ON ON g 2 e i T
p || EWS, e 199, 359, o [51%
Light ON ON Y@ 0 [0, %0, o 529,
DX Button ON P 5

ON o, [ lo 210, [ lo @7 [ [o 1830, | o

After clicking, a file dialog will be displayed to select the .pdf file. Select the FSSB_R3 >
Doc folder and finally the FSSB-R3 User Guide.

13% DOCUMENTATION X

« « 4 || < RealSimulator Data > FSSBR3 > Doc v @] | BuscarenDoc

-
Organizar v Nueva carpeta =~ O @
@ OneDrive ~ Nombre Fecha de T

AEROBATIC_1.00.0

MIF_1.05.2
& Descergas SSF_1.00.0

I Desktop = FS5B-R3 User Guide V2.014p

B Objetos 3D

B videos

‘&, W10_Programas

Nombre: v‘ PDF (pd) ~

Finally, click the Open button to open the User Guide.

LOAD, SAVE AND PRINT A . XML CONFIGURATION FILE

So far, we have seen how to configure the grip slots, but we have not talked about what
you can do when the configurations are done.

Usually, you can load configurations saved previously or copied from other users, and
you will also need to save the configurations when finished or while modifying. To do
this, the program offers in the upper menu bar the next File actions:

e Open: to open an .xml configurations file and load it as active in the program and
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save it in the stick if it is connected (see the next section for offline mode).
e Save: to save the actual slots configuration with the same name as actual.

e Save As: to save the actual slots configuration with a different name from actual.

When a configuration file is opened, it is sent to the device to be active. Slots
configuration is stored in non-volatile area but keystrokes information is stored in the
memory area (volatile area). Although you can work with it immediately don’t forget that
if you want it remains on the device after a shutdown, you must press the displayed
alert button and save it in flash area. If you only want to run some tests, don’t save it on
flash, so you will extend your device life.

Another option of the program is the ability to print a template of RS grips
(F1I6SGRH/F18CGRH) with the explanations for an easy and quick location of actions
in each slot. This option is not available for TM compatible grips.

To access the print option, click on File in the upper menu bar and select Print, a new
window will be displayed similar to those shown below in function of RS grip connected.
If the grip connected is the FI6SGRH you will see this template:

o5l PrintGripF16 - m} x

Slot Name Take OFF / NAV
: ------------- : : ': = Slot Number
H Print Print Actual 2 .| ALL Actives 1 . 3 |4 |5 |6 7|8 =
Print Selection | -» : : :

Print Preview
™"

Slot Selection

R o -
HSDRglner ICPSD
Empty Empty 2
) 4{ DMSRight
RadRabn GearToagle RadRalp Empty Key%{
ThrottleStpDn : T
HSDRgDecr i
Key 7
Trigger 1
Trigger 2
| TMs | &
ICPEntr Key 5
icP1 NWS o2
Ematy ICPRal
cpe|  EmV icFz Key 3
ICPList
ICP3.
CMS Pinkcy
JSEDERLE SpdSKOFF| . [SedBikOn
e Position Lis =ring Empty
ICPDCSRn oty ICPDCSSeq
ICPD e ICP3
ICPDCSDn
ICPPrevious

Paddle BRAKES

. . C:\Users'Bartolome\App Data‘\RoamingReal Simulator Data'\F55B R3\BMS433u1 xml
File Information | —p- p=— 1. rv 2 00 0 T 552020 05:12:50
| Slot configueation o 000000000 _____|

M Slot configuration

HAT I3l 50
E Keystrokes [{of] Roll Cirl Assistance [ DX Buttons [f&i]
Slot H Full Scale Control [E5383 BFA Roll level QIS DX center Buttons [Juelie
Configuration | - EEEEEZIE===TY 1.5 e [ Sound |l
 Pitch Sensibility [FEIT o On
[l NASA Roll Sensability [J} 100 o
H  Mouse Button | | Shiter [
H Shifter Slot |§] Toggle [{8] Toggle Slot [§]
E_____________ Tim [y
R R R R R R AR R AN N AN AN NN SN N AN AN AN NEN NN AN NEAE NS AN EAENEAENEEEEEEEEEREEEREEEY
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And similarly, if you have connected the RS F-18 grip, you will have this template:

85! PrintGripF16 m} X
Take OFF / NAV
Print Print Actual ALL Actives P 225 [s [7][s 2
Print Preview TRIM 2
Empty
ATC Menu
— - Empty
= " [
ThrottleStpLip Empty
DMSL
HSDRglncr Element \CF‘SD
Empty Empty -
y 4{ DMSRight
RadRgDn GearTogde RadRgllp Empty Key%{
ThrottleStpDn
HS0RaD DMSDown
gliecr Key 7
Trigger 1
Trigger 2
s | e
ICPEntr ey, —
ICP1 NWS £
Empty ICPRd
icP4 Fpty IcP2 ¥l
ICPList
IcP3
CMS
ICPDCS Up
ICPNext
ICPDCSRin . ICPDCSSeq
ICP0 T ICP3
ICPDCSDn
ICPPrevious
Y™ C:\Users\Bartolome'AppData'\Roaming\RealSimulator Data'\FSSB R3\BMS433uT xml
| Fimware [N ™Y 502020 05.07:15
Slot configuration
HAT [0 Yaw Sensibility 50
On Roll Ctrl Assistancc [{o) Off
44 Med DX center Buttons [[NSES
[l 1.30b BFA Pitch level |5 [ Sound o}
Fitch Sensibility [[EE Off On
NASA Roll Sensibility [ NASA Pitch Sensibility [ Off
off
1 Off 1
off

There, in the upper part, you can find the Slot Name and Slot number of the slot shown
and in the lower part the File Information and the Slot Configuration.

Also, in the upper part, you can see the Print Selection area that enables you to print
the slot shown, using the button “Print Actual” or to print the slots selected in the Slot
Selection with the “Print” button.

The Slot Selection has two buttons to quickly select all slots with the “ALL” button, or
only the active slots with the “Actives” button. Also, there are two lines with box
numbers where all slots are shown (upper line) and only the active slots (lower line).

In the upper line, the 8 slots are shown, in green colour for the actives, in grey colour for
the empty slots and in red colour for the slots manually disabled with a click in the box
number.

In the lower line, only the active slots are shown, all in green colour and the shown slot
in lime colour.
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To print only one slot, first select the slot in the lower line by clicking the box number
and it will change to lime colour. Finally, click the Print Active button.

To print a selection of slots, first click the ALL or the Active button if you want to print a
selection of actives and no active slots or only active slots. Disable the undesired slots
by clicking on them to change to the red colour. Finally, press the Print button.

RS HID_DEV_TOOL and FSSB-R3L + TM compatible Grips

In sections previous we have seen how this firmware works with the RS grips and now
in this section we will see how it works with the TM compatible grips, as the TM Cougar,
TM Warthog, TM F-18, etc.

As these grips don’t have rotary switch, the R3L works like with the classic firmwares
and it only has available the 4 standard slots and the user must use the SMM launcher
to access to special features.

At this moment this firmware includes the features and differences of next firmwares:

e MJF: the new firmware includes all features of original firmware with the
difference of only a second set of DX buttons (the original firmware has two
additional sets of DX buttons).

e BMS: this firmware includes all features of original firmware, but unlike the
original has a second set of DX buttons (the original firmware doesn’t have
additional set of DX buttons), the SMM launcher is the standard, it has operative
the Angle Adjust although you can set it to 0° and to cancel the dead zone like in
the original firmware, you can set the BFA Roll and Pitch levels to Off.

e AER: this firmware is not full integrate yet, only has available the BFA adjust and
the Roll Control Assistance. The Trim in axes, immediate access to Memory
Slots, Roll and Pitch Sensibility without use the SMM launcher and finally a direct
function assigned to NWS button to change the Full Scale Control to 4:4 while
pressed are not supported.

As resume, this firmware has integrated the next features that user can use or not,
setting it to your liking:

e SMM (Special Mode Menu) launcher: Paddle + Pinky / CMS Centre.

e HAT switch: POV / TRIM.

e Sound: ON/ OFF.

e Light: ON/OFF.

e DX Button: ON/ OFF.

e Full Scale Control (FSC): 4:4/3:4/2:41 1:4.

e Roll Sensibility: 1,3 .... 13 Ib.

¢ NASA Roll Sensibility: 50% .... 200%.

e Pitch Sensibility: 1,75 .... 13 Ib.

e NASA Pitch Sensibility: 50% .... 200%.

e BFA Roll Level: Off — Min — Med — High — Full.

e BFA Pitch Level: Off — Min — Med — High — Full.
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e Warning Sound Level: 1% .... 99%.

e Angle Adjust: -180° .... 180°.

e Roll Control Assistance (RCA): ON / OFF.
e Precision Mode: ON / OFF (0-100%).

In the RS_HID_DEV_TOOL window you can see the previous features enabled and the
rest disabled in gray. In previous sections of this chapter, you can see a detailed
explanation about how each one works.

%%
File Help
FSSBR3RH | FSSBRILH TUSBAR2 RUSBA FUSBA Magind & SpeedBrake FIG/FIBRH F16/18LH RS-35LTB Rudder
BACKUP . P8 01 0 Slot 1 = Slot Name->  Take off Explanation Names
imware FUE_PWS 019 oad g DrectXbution
SMM ' 2 [E@ o [ L ¢
Special Mode Meny | Po3de +Pky | Paddie <Py | [0 [0 % o [16°, 0 [329, o @m0, .
0 o« e 2 @0 o [0 ¢
e T = B e o [779 o [@33Y, o [@Y, 0
= c| Eme, o B0, o [30, o [5000, o
Sound oN
o 3, o [199, 0 [359, o [51%, o
OoN
et o e, o [200%, o [39, s [529, o
DX Button
DMS (FSC) = - = Lt e ce ’
Full Scale Cortral : s B, o [Z°, e o [ °, P
Rol Sensbity | 433b |13 133b | e, o [Bo, o [E@o, . B, g
NASA Rol Sensbity [ 1007 | = W 50, o [28%, o [@07°, o 567, o
Pich Sensbil =
ty | 850k 850 50, o [0, o @70, o [57°, e
NASA Pitch Sensbil % |
fy [ 100% | 100 0% o [26°% o [827% o [88% &
0, o [T o [33°%, o [53°, 0
Roll Control Assistance (RCA)
oll Corttrol Assistance (RCA) OFF OFF 0, o [, o [@0, o [600%
BFA Rolllevel 3 e, o @, o [35°, o 6T,
BFA Pich level 3 @, o @, o @B, . 629, e
Precision Mode | orp 2] oFF B, o [@T°, o [@770, o [E@% o
Output
DX Center Buttons oN oN
Waning Sound Level z
Digital Mouse Switch Nore | 5 None
it 1 e
Digital Mouse Speed 1 Axes Measure e PITCH
‘ Digtal Mouse Button | Trigger 1| & Trigger 1 =
i Left |I%
| B Left Trim Roll ) Roll X 32768
Shiter Buton | None | * None
Trim Pitch 0 Pitch Y -32753
Shiter Slot number 1 & | {
Toagle Buton None |3 None
Toggle Slot Number 1 [ |
= o
Hardware TRIM | goth  |[ 2 Beth » 2
Set Tim Button | cpMS coms =
Reset Trim Button | pagdie || = =
. — e VACROS
Overlay Settings
Game Mode
Corf Mode moe | L1 L
Adst W DX Massures 5] Flaw Measuies
WWW.RealSimulator.com.

The Roll Control Assistance (RCA) and the Precision Mode are only configurable by the
RS_HID_DEV_TOOL tool, its activation or deactivation must be managed by changing
the slot.

In the next table we show the correspondence of each DX button and the associated
switch. Pay attention because the DX TRIM buttons are located in different positions
that on the classic firmwares.

DX Button Function
Trigger 1
Weapon Release
Pinky
Paddle
NWS/Missile step
Trigger 2
TMS Up
TMS Right
TMS Down
TMS Left
DMS Up

Blo|o|~N|o|a|s|wn|k|o

741110




11 DMS Right
12 DMS Down
13 DMS Left
14 CMS Up
15 CMS Right
16 CMS Down
17 CMS Left
18 CMS Centre
19 - 26 Spare
27 Trim Up
28 Trim Right
29 Trim Down
30 Trim Left
31-63 Spare

DX Trim buttons are always operatives whether the HAT button is on TRIM or POV
option; POV (Point of View) option is only operative when HAT button is on POV.

Next, we will show you the special options included in this firmware and that you can
launch from the grip directly as with the classic firmwares.

SMM (SPECIAL MODES MENU) LAUNCHER

It allows change between “Paddle + Pinky” and “CMS Centre” as launcher of Special
Modes Menu. The Cougar stick does not have physically this switch, so if you use this
stick, you never have to use the CMS Centre option as SMM launcher, because will be
impossible do it from the stick.

The Paddle + Pinky option as launcher does not require a sequence; the condition is
both switches pressed at the same time.

How it works:

- Change to CMS Centre as launcher.

Press Paddle + Pinky -> beep, beep -> press CMS centre.

- Change to Paddle + Pinky as launcher.
Press CMS Centre -> beep, beep -> press Paddle + Pinky.

NEUTRAL POSITION ADJUSTMENT (NPA)

NPA let you at any time, even in flight time, adjust or compensate any possible physical
distortion in the gravity vector over you FSSB R3L.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Triggerl, leave the stick alone and wait until the sounds finish.

HAT AS POV OR TRIM

The HAT switch can be modified at any time to behave like a POV (default) or TRIM
command. This allows the HAT during the use of the joystick, control the views or
submit your information to 4 HID buttons for use as TRIM, which is its function in real
life.

How it works:
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Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press HAT Up -> HAT as POV (Default)
Press HAT Down -> HAT as TRIM control over DX buttons 27, 28, 29 and 30

SOUND ON/OFF CONTROL

Let you activate and deactivate the beep sound.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Paddle + HAT Left two seconds -> Deactivate sound
Press HAT Left two seconds -> Activate sound

FULLL SCALE CONTROL (FSC)

With the FSC you can control the full deflection of your control surfaces (if you are using
a plane, or full wheels angle in case of a truck or car) in 4 levels using the DMS 4 ways
switch.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press DMS Up -> 4:4 Full range (default)

Press DMS Right -> 3:4 Full range

Press DMS Down -> 2:4 Full range

Press DMS Left -> 1:4 Full range

ROLL AND PITCH SENSIBILITY CONTROL

TMS controls sensibility in Roll and Pitch axes. There are two ways to adjust the
sensibility in axes, with preset values or continuously step by step, every 0.5 Ib.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)

press Paddle + TMS Up -> Pitch to Combat Mode (too aggressive), 4 Ib. full deflection
press Paddle + TMS Right -> Pitch to Normal Mode, with 8.5 Ib. full deflection (default)
press Paddle + TMS Down -> Pitch to Smooth Mode, with 10.75 Ib. full deflection
press Paddle + TMS Left -> Pitch to too Smooth Mode, with 13 Ib. full deflection

press TMS Up -> Roll to Combat Mode (too aggressive) , 1.30 Ib. full deflection
press TMS Right -> Roll to Normal Mode, with 4.33 Ib. full deflection (default)
press TMS Down -> Roll to Smooth Mode, with 6.5 Ib. full deflection

press TMS Left -> Roll to too Smooth Mode, with 13 Ib. full deflection

Pinky Pressed continuous adjustment

Press Pinky + TMS Up to increase step by step sensibility on pitch.
Press Pinky + TMS Down to decrease step by step sensibility on pitch
Press Pinky + TMS Right to increase step by step sensibility on roll
Press Pinky + TMS Left to decrease step by step sensibility on roll

When you increase the Sensibility, you will hear a 4 beeps sound
When you decrease the Sensibility, you will hear a 2 beeps sound
When you reach the limit, you will hear a continuous sound
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ZEROIZE

Launching the Zeroize option you will reset all variables to default values.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Trigger2 -> Zeroize will set all variables to default values.

MEMORY SLOTS

The FSSB R3L has four memory slots to save custom configurations. "Memory Slot"
makes custom option of the R3L handling very comfortable to use in flight. With only 2
actions (enter SMM mode + one button press) select a large bunch of parameters.

How it works:

To program a profile (save the configuration in the slot)

Configure the R3L as you like even SMM, and:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Paddle and hold it pressed.

Press CMS in one way for two seconds.

UP -> Slot 1.

RIGHT -> Slot 2.

DOWN -> Slot 3.

LEFT -> Slot 4.

To recover a profile (load data from the slot and configure the R3L)
Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press CMS in one way for two seconds.

UP -> Slot 1.

RIGHT -> Slot 2.

DOWN -> Slot 3.

LEFT -> Slot 4.

When R3L power up, auto load the Memory Slot 1 if available.
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EMYCSA SSF Firmware
Rea|S|mUIat0r Date: 29-12-2022 Version: 3.01

PICTURE

4% RealSimulator HID Device Tool V1,08 - X

(FSSERIAH] FSSBR3LH TUSBARZ RUSBA FUSBA Magind & SpeedBrake
Slot 1 Siot 2 Siot 3 Slot 4.
Load | | Save Load | | Save Load || Save Load || Save

5
Special Mode Meny | P2ddle « Pinky Padde + Prnky

CMS Centre CMS Cerire CMS Cerire
HAT Ea POV POV POV POV
Sound oN on on oN on
Light ON oN oN oN oN
DX Buiton oN Féfn"“;’:: oN ON ON ON
iscac o [ 4212 [ -] -] [-]
s ot sty T
Pich Sensibity -] -] [ ]
BFARol level =
BFAPrch level <
Precision Mode oN oN oN oN oN
Swap Roll/Yaw Permanent oN oN oN oN oN
Enable Keep Rate OoN on on oN oN

Absolute:

Rolx [ 32768 |
Pitch Y

LAR
Ii
B

LAST PUBLISHED FIRMWARE VERSIONS: SSF_FW_2 00 _2.FSSB_R3

DESCRIPTION

SSF firmware is the MJF firmware customized with the suggestions and necessities of
space ships fighter gamers. The modifications included are a third axis (Yaw), only one
additional DX Button set, and some controls and functions to improve the flight
precision and swap between axes quickly. It is only supported by RS _HID DEV_TOOL
v1.12.

When you plug in the FSSB-R3L with the SSF
firmware installed to an USB port, the joystick
W|” be dISp|ay6d |n WII’IdOWS and a” '._..,' ngn:rsstmegiLEg:. help you configure the game controllers installed on
applications that can handle HID devices, with
the name “FSSB R3 SSF RH”, as you can

#% Game Controllers *

Installed game controllers

Controller Status

see in the next image in the Game Controllers
window. FSSB R3 S5F RH oK

NOTE: some operating systems do not
change the name directly and you find “FSSB
R3 Warthog”, but after launch the Advanced.. Broperties
RS_HID_DEV_TOOL with the device plugged

the name will change to “FSSB R3 SSF RH”.
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In this case, you can see two FSSB R3 SSF RH devices. The first (upper) show the
standard joystick information, i.e., Roll, Pitch and Yaw axes, 32 DX buttons and Point

of View Hat, and the other (lower) only show a second DX buttons set.

& FSSB R3 55F RH properties b4

Seftings ]

Test the game controller. i the cortroller is not functioning property, it may
need to be calibrated. To calibrate it, go to the Settings page.
Pues

M. Z fois

X Bods /Y Pods

Buttons
2000060OGOO
o00O0GOGOOGO
2000OGDOGOGS
200000 OGOS

Paint of View Hat

O

‘# FSSE R3 S5F RH properties

Test the game controller. i the controller is not functioning propery, it may
need to be calibrated. To calibrate it, go to the Settings page.

Buttons

With the RS_HID_DEV_TOOL program you have the possibility of enable or remove
the second device. If you remove it, when open the Game Controllers window you will

Cance! Bpply Cancel Boply
First device Second device

get the next window with only the first and main device.

Next, we show in a table the correspondence of each button and the associated

switch.

#“¥ Game Controllers

your computer.

Installed game controllers

; These settings help you configure the game controllers installed on

x

Cortroller
F55B R3 55F RH

Status
oK

Advanced...

Properties

First device Second device
Button Press directly Press Paddle +
1 Trigger 1 Trigger 1
2 Weapon Release Weapon Release
3 Pinky Pinky
4 Paddle Paddle
5 NWS/Missile step NWS/Missile step
6 Trigger 2 Trigger 2
7 TMS Up TMS Up
8 TMS Right TMS Right
9 TMS Down TMS Down
10 TMS Left TMS Left
11 DMS Up DMS Up
12 DMS Right DMS Right
13 DMS Down DMS Down
14 DMS Left DMS Left
15 CMS Up CMS Up
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16 CMS Right CMS Right
17 CMS Down CMS Down
18 CMS Left CMS Left
19 CMS Centre CMS Centre
20 Trim Up Trim Up
21 Trim Right Trim Right
22 Trim Down Trim Down
23 Trim Left Trim Left
24 - 32 Spare Spare

Trim buttons (20 to 23) are operatives when HAT is in TRIM option; in POV (Point of
View) option is operative the DX Point of View HAT.

As we can see in the previous table the Second DX button set is available with the

Paddle switch pressed.

When we launch the RS_HID_DEV_TOOL with the SSF firmware installed we must

see a window like this:

%% RealSimulator HID Device Tool V1.08 - X
[FSSEHIAN] FSSBR3LH TUSBAR2 RUSBA FUSBA Magind & SpeedBrake
Siot 1 Siot 2 Siot 3 Siot 4
Tz SRR Load | | Save Load | | Save Load | | Save Load | | Save
SMM
Special Mods Menu | F2ddle + Finky Paddle + Pinky CMS Certre CMS Cartrs CMS Certre
HAT POV POV POV POV POV
Sound ON ON on ON ON
Light ON ON ON ON ON
Remove
e ON Butions OoN oN ON oN
DMS (FSC) =
Full Scale Cortral - [ w | [ - ] [ - ] [ -]
Roll Sensibiity [ 23316 |+ [4an | - -] -
NASA Roll Sensibiity | 100% | = 100% 0% 0% 0%
Pitch Sensibility 850 | ‘ 8501 | ~ | _ ‘ ~
NASA Pitch Sensibilty : [ | 00% [0 ] 100 %
BFA ol level = [mn | [4a ] [ 24 | [ 44 |
BFAPichlevel [ Mn |12 [ mn | [oe ] [ b ] [Coe ]
Frecision Mode ON oN on ON on
Swap Roll/Yaw Pemanent ON oN on ON on
Enable Keep Rate ON ON OoN ON on
Warming Sound Level = [s0% | [ou | [ox | [ou |
Axes Measure
Dol
RolX | 32788
Pitch ¥
YAW
In Space Ship Fighters firmware.
Pinky is the hot switch used plus
TMS or DMS control the special B
S5F features.
Angle
Adjust
MYCSA WWW RealSimulator.com

In the Slot Configuration section of MJF_FW_F16-18 Firmware chapter, you will find
a detailed explanation of each setting to manage and configure your R3L with this tool.

As we can see in the previous image, the RS_HID DEV_TOOL allows to configure the
next settings in the SSF firmware:

e SMM (Special Mode Menu) launcher: Paddle + Pinky / CMS Centre.
e HAT switch: POV / TRIM.
e Sound: ON/ OFF.
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e Light: ON/OFF.

e DX Button: ON/ OFF.

e Add/Remove Buttons: 1/ 2 devices.

e Full Scale Control (FSC): 4:4/3:4/2:41 1:4.
e Roll Sensibility: 1,3 .... 13 |b.

¢ NASA Roll Sensibility: 50% .... 200%.

e Pitch Sensibility: 4 .... 13 Ib.

e NASA Pitch Sensibility: 50% .... 200%.

e BFA Roll Level: Off — Min — Med — High — Full.
e BFA Pitch Level: Off — Min — Med — High — Full.
e Precision Mode: ON / OFF.

e Swap Roll/Yaw Permanent: ON / OFF.

e Enable Keep Rate: ON / OFF.

e Warning Sound Level: 1% .... 99%.

e Angle Adjust: -180° .... 180°.

It is important to know that previous settings can be configured fully with the
RS _HID_DEV_TOOL but there are others settings/actions that can only be done with
the SMM of stick, as for example the NPA or Zeroize features. Also, some previous
settings are not available with the SMM.

In Power up sequence, FSSB-R3L loads the Memory Slot 1 as actual configuration,
this allows user to have a custom start configuration. If the memory slot 1 is not
configured, then loads the default values, as in the Zeroize option.

To get a quick control to swap axes SSF firmware use Pinky as HOT-SWITCH. So,
you do not need enter in SMM to get access to the special SSF features. Only press
and hold Pinky to increase your precision by 2 or in combination with TMS or DMS
configure your axes response.

For a quick user action, the SSF direct modes can be executed indistinctly with DMS or
TMS hats.

SPECIAL OPTIONS DESCRIPTION

Next, we will show you the special options included in this firmware.

SMM (SPECIAL MODES MENU) LAUNCHER

It allows change between “Paddle + Pinky” and “CMS Centre” as launcher of Special
Modes Menu. The Cougar stick does not have physically this switch, so if you use this
stick, you never have to use the CMS Centre option as SMM launcher, because will be
impossible do it from the stick.

The Paddle + Pinky option as launcher does not require a sequence; the condition is
both switches pressed at the same time.

How it works:
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- Change to CMS Centre as launcher.
Press Paddle + Pinky -> beep, beep -> press CMS centre.

- Change to Paddle + Pinky as launcher.
Press CMS Centre -> beep, beep -> press Paddle + Pinky.

NEUTRAL POSITION ADJUSTMENT (NPA)

NPA let you at any time, even in flight time, adjust or compensate any possible
physical distortion in the gravity vector over you FSSB R3L.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Triggerl, leave the stick alone and wait until the sounds finish.

HAT AS POV OR TRIM

The HAT switch can be modified at any time to behave like a POV (default) or TRIM
command. This allows the HAT during the use of the joystick, control the views or
submit your information to 4 HID buttons for use as TRIM, which is its function in real
life.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press HAT Up -> HAT as POV (Default)
Press HAT Down -> HAT as TRIM control over DX buttons 20, 21, 22 and 23

SOUND ON/OFF CONTROL

Let you activate and deactivate the beep sound.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Paddle + HAT Left two seconds -> Deactivate sound
Press HAT Left two seconds -> Activate sound

DX AUX BUTTON SET ON/OFF

Second DX buttons set can be turned ON and OFF if needed to avoid conflict when
used with external or internal mapping tools.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Paddle + HAT Right two seconds. Deactivate DX buttons set 2 and 3.
Press HAT Right two seconds. Activate DX buttons set 2 and 3.

FULL SCALE CONTROL (FSC)

With the FSC you can control the full deflection of your control surfaces (if you are
using a plane, or full wheels angle in case of a truck or car) in 4 levels using the DMS 4
ways switch.
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How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press DMS Up -> 4:4 Full range (default)

Press DMS Right -> 3:4 Full range

Press DMS Down -> 2:4 Full range

Press DMS Left -> 1:4 Full range

ROLL AND PITCH SENSIBILITY CONTROL

TMS controls sensibility in Roll and Pitch axes. There are two ways to adjust the
sensibility in axes, with preset values or continuously step by step, every 0.5 Ib.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)

press Paddle + TMS Up -> Pitch to Combat Mode (too aggressive), 4 Ib. full deflection
press Paddle + TMS Right -> Pitch to Normal Mode, with 8.5 Ib. full deflection (default)
press Paddle + TMS Down -> Pitch to Smooth Mode, with 10.75 Ib. full deflection
press Paddle + TMS Left -> Pitch to too Smooth Mode, with 13 Ib. full deflection

press TMS Up -> Roll to Combat Mode (too aggressive) , 1.30 Ib. full deflection
press TMS Right -> Roll to Normal Mode, with 4.33 Ib. full deflection (default)
press TMS Down -> Roll to Smooth Mode, with 6.5 Ib. full deflection

press TMS Left -> Roll to too Smooth Mode, with 13 Ib. full deflection

Pinky Pressed continuous adjustment

Press Pinky + TMS Up to increase step by step sensibility on pitch.
Press Pinky + TMS Down to decrease step by step sensibility on pitch
Press Pinky + TMS Right to increase step by step sensibility on roll
Press Pinky + TMS Left to decrease step by step sensibility on roll

When you increase the Sensibility, you will hear a 4 beeps sound
When you decrease the Sensibility, you will hear a 2 beeps sound
When you reach the limit, you will hear a continuous sound

ZEROIZE

Launching the Zeroize option you will reset all variables to default values.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Trigger2 -> Zeroize will set all variables to default values.

MEMORY SLOTS

The FSSB R3L has four memory slots to save custom configurations. "Memory Slot"
makes custom option of the R3L handling very comfortable to use in flight. With only 2
actions (enter SMM mode + one button press) select a large bunch of parameters.

How it works:

To program a profile (save the configuration in the slot)
Configure the R3L as you like even SMM, and:
Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
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Press Paddle and hold it pressed.
Press CMS in one way for two seconds.
UP -> Slot 1.

RIGHT -> Slot 2.

DOWN -> Slot 3.

LEFT -> Slot 4.

To recover a profile (load data from the slot and configure the R3L)
Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press CMS in one way for two seconds.

UP -> Slot 1.

RIGHT -> Slot 2.

DOWN -> Slot 3.

LEFT -> Slot 4.

When R3L power up, auto load the Memory Slot 1 if available.

PRECISION MODE ON/OFF
You can enable and disable the precision mode with Pinky + TMS or DMS Up.

If enable, when you press Pinky the sensibility in axes will change to half.

SWAP ROLL/YAW

The main feature of SSF is the ability to swap between Roll and Yaw axes. This
happen when your press pinky; by default, with Pinky released your X axis drive the
Roll and when you press Pinky your X axis drive Yaw, but you have the possibility to
invert this and also to do permanent the actual selection, we will show:

- Pinky + TMS or DMS Down, do permanent the actual selection and pinky don’t
swap the axes.
- Pinky + TMS or DMS Left:

¢ |If we come from “permanent” this action will disable permanent and the swap
Roll/Yaw system will become active with Pinky. This is called “momentary”.

¢ |f we come from “momentary” the actual Roll/Yaw axes will be swap; to swap
again and goes to previous situation press Pinky + TMS or DMS Left again.

ENABLE/DISABLE KEEP RATE

You can change between enable and disable the Keep Rate mode with Pinky + TMS
or DMS Right.

If enable, every time you swap between Roll/Yaw axes, the keep rate of the swapped
axis will be kept; this let you keep the roll keep while you modify the yaw to turn over
and shoot your opponent.
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DESCRIPTION

SSF LH firmware is the SSF firmware for left hand joysticks. At this moment the
firmware has the same features than RH firmware but has been customized with a
different VID_PID to allow the coexistence with the standard right hand FSSB-R3. It is
only supported by RS HID DEV_TOOL v1.12.

As it has a different VID_PID identification, we need press the tab FSSB R3 LH to
configure it and see the actual settings.

RS_HID_DEV_TOOL with the device plugged,
the name will change to “FSSB R3 SSF LH”.

#% Game Controllers X
When you plug in the FSSB-R3L with the SSF | s e setngshebyou comigusthe game contolers nsaled on
LH firmware installed to an USB port, the | S qame conolers
joystick will be displayed in Windows and all | [, ... —_
applications that can handle HID devices, with FSSB R 5SF LH 0K
the name “FSSB R3 SSF LH”, as you can see in FOSB 3 SoF LA oK
the next image in the Game Controllers window.
NOTE: some operating systems do not change vt s
the name directly and you find “FSSB R3 : B
Warthog”, but after launch the
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In this case, you can see two FSSB R3 SSF LH devices. The first (upper) show the
standard joystick information, i.e., Roll, Pitch and Yaw axes, 32 DX buttons and Point
of View Hat, and the other (lower) only show a second DX buttons set.

& FSSB R3 55F LH properties b

Seftings ||

Test the game controller. i the controller is not functioning propery. it may
need to be calibrated. To calibrate it, go to the Settings page.

Pues

‘# FS5B R3 55F LH properties

Test the game controller. i the controller is not functioning propery, it may
need to be calibrated. To calibrate it, go to the Settings page.

[ Z Puds
+
X Bis /Y Podis
Buttons Point of View Hat Buttons
200000006 200006006060
X N N N N N N J A N N N N N N J
0000O0DGSS 00000 GSS
X N N N N N N J K N N N N N N J
Cancel Boply Cancel Boply
First device Second device

With the RS_HID_DEV_TOOL program you have the possibility of enable or remove
the second device. If you remove it, when open the Game Controllers window you will

get the next window with only the first and main device.

Next, we show in a table the correspondence of each button and the associated

switch.
First device Second device

Button Press directly Press Paddle +

1 Trigger 1 Trigger 1

2 Weapon Release Weapon Release

3 Pinky Pinky

4 Paddle Paddle

5 NWS/Missile step NWS/Missile step

6 Trigger 2 Trigger 2

7 TMS Up TMS Up

8 TMS Right TMS Right

9 TMS Down TMS Down

10 TMS Left TMS Left

11 DMS Up DMS Up

12 DMS Right DMS Right

13 DMS Down DMS Down
14 DMS Left DMS Letft

15 CMS Up CMS Up

¥ Game Controllers

These settings help you configure the game controllers installed on

"i your computer.

Installed game controllers

X

Controller
F55B R3 S5F LH

Status
OK

Advanced...

Propetties
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16 CMS Right CMS Right
17 CMS Down CMS Down
18 CMS Left CMS Left
19 CMS Centre CMS Centre
20 Trim Up Trim Up
21 Trim Right Trim Right
22 Trim Down Trim Down
23 Trim Left Trim Left
24 - 32 Spare Spare

Trim buttons (20 to 23) are operatives when HAT is in TRIM option; in POV (Point of
View) option is operative the DX Point of View HAT.

As we can see in the previous table the Second DX button set is available with the

Paddle switch pressed.

When we launch the RS _HID DEV_TOOL with the SSF_LH firmware installed we

must see a window like this:

1%% RealSimulator HID Device Tool V1.08

FSSBR3IRH FSSBR3LH TUSBAR2 RUSBA

SSF_LH 2 000
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Sound ON
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Pinky is the hot switch used plus
TWS or DMS control the special
SSF features.
Angle
Adidst
WWW.RealSimulator.com

In the Slot Configuration section of MJF_FW_F16-18 Firmware chapter, you will find
a detailed explanation of each setting to manage and configure your R3L with this tool.

As we can see in the previous image, the RS_HID_DEV_TOOL allows to configure the
next settings in the SSF firmware:

[ ]

e HAT switch: POV / TRIM.
e Sound: ON / OFF.

e Light: ON/OFF.

SMM (Special Mode Menu) launcher: Paddle + Pinky / CMS Centre.
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e DX Button: ON/ OFF.

e Add/Remove Buttons: 1/ 2 devices.

e Full Scale Control (FSC): 4:4/3:4/2:4] 1:4.
¢ Roll Sensibility: 1,3 .... 13 Ib.

e NASA Roll Sensibility: 50% .... 200%.

e Pitch Sensibility: 4 .... 13 |b.

e NASA Pitch Sensibility: 50% .... 200%.

e BFA Roll Level: Off — Min — Med — High — Full.
e BFA Pitch Level: Off — Min — Med — High — Full.
e Precision Mode: ON / OFF.

e Swap Roll/Yaw Permanent: ON / OFF.

e Enable Keep Rate: ON / OFF.

e Warning Sound Level: 1% .... 99%.

e Angle Adjust: -180° .... 180°.

It is important to know that previous settings can be configured fully with the
RS_HID_DEV_TOOL but there are others settings/actions that can only be done with
the SMM of stick, as for example the NPA or Zeroize features. Also, some previous
settings are not available with the SMM.

In Power up sequence, FSSB-R3L loads the Memory Slot 1 as actual configuration,
this allows user to have a custom start configuration. If the memory slot 1 is not
configured, then loads the default values, as in the Zeroize option.

To get a quick control to swap axes SSF LH firmware use Pinky as HOT-SWITCH. So,
you do not need enter in SMM to get access to the special SSF features. Only press
and hold Pinky to increase your precision by 2 or in combination with TMS or DMS
configure your axes response.

For a quick user action, the SSF direct modes can be executed indistinctly with DMS or
TMS hats.

SPECIAL OPTIONS DESCRIPTION

Next, we will show you the special options included in this firmware.

SMM (SPECIAL MODES MENU) LAUNCHER

It allows change between “Paddle + Pinky” and “CMS Centre” as launcher of Special
Modes Menu. The Cougar stick does not have physically this switch, so if you use this
stick, you never have to use the CMS Centre option as SMM launcher, because will be
impossible do it from the stick.

The Paddle + Pinky option as launcher does not require a sequence; the condition is
both switches pressed at the same time.

How it works:

- Change to CMS Centre as launcher.
Press Paddle + Pinky -> beep, beep -> press CMS centre.
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- Change to Paddle + Pinky as launcher.
Press CMS Centre -> beep, beep -> press Paddle + Pinky.

NEUTRAL POSITION ADJUSTMENT (NPA)

NPA let you at any time, even in flight time, adjust or compensate any possible
physical distortion in the gravity vector over you FSSB R3.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Triggerl, leave the stick alone and wait until the sounds finish.

HAT AS POV OR TRIM

The HAT switch can be modified at any time to behave like a POV (default) or TRIM
command. This allows the HAT during the use of the joystick, control the views or
submit your information to 4 HID buttons for use as TRIM, which is its function in real
life.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press HAT Up -> HAT as POV (Default)
Press HAT Down -> HAT as TRIM control over DX buttons 20, 21, 22 and 23

SOUND ON/OFF CONTROL

Let you activate and deactivate the beep sound.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Paddle + HAT Left two seconds -> Deactivate sound
Press HAT Left two seconds -> Activate sound

DX AUX BUTTON SET ON/OFF

Second DX buttons set can be turned ON and OFF if needed to avoid conflict when
used with external or internal mapping tools.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Paddle + HAT Right two seconds. Deactivate DX buttons set 2 and 3.
Press HAT Right two seconds. Activate DX buttons set 2 and 3.

FULL SCALE CONTROL (FSC)

With the FSC you can control the full deflection of your control surfaces (if you are
using a plane, or full wheels angle in case of a truck or car) in 4 levels using the DMS 4
ways switch.

How it works:
Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
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Press DMS Up -> 4:4 Full range (default)
Press DMS Right -> 3:4 Full range
Press DMS Down -> 2:4 Full range
Press DMS Left -> 1:4 Full range

ROLL AND PITCH SENSIBILITY CONTROL

TMS controls sensibility in Roll and Pitch axes. There are two ways to adjust the
sensibility in axes, with preset values or continuously step by step, every 0.5 Ib.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)

press Paddle + TMS Up -> Pitch to Combat Mode (too aggressive), 4 Ib. full deflection
press Paddle + TMS Right -> Pitch to Normal Mode, with 8.5 Ib. full deflection (default)
press Paddle + TMS Down -> Pitch to Smooth Mode, with 10.75 Ib. full deflection
press Paddle + TMS Left -> Pitch to too Smooth Mode, with 13 Ib. full deflection

press TMS Up -> Roll to Combat Mode (too aggressive) , 1.30 Ib. full deflection
press TMS Right -> Roll to Normal Mode, with 4.33 Ib. full deflection (default)
press TMS Down -> Roll to Smooth Mode, with 6.5 Ib. full deflection

press TMS Left -> Roll to too Smooth Mode, with 13 Ib. full deflection

Pinky Pressed continuous adjustment

Press Pinky + TMS Up to increase step by step sensibility on pitch.
Press Pinky + TMS Down to decrease step by step sensibility on pitch
Press Pinky + TMS Right to increase step by step sensibility on roll
Press Pinky + TMS Left to decrease step by step sensibility on roll

When you increase the Sensibility, you will hear a 4 beeps sound
When you decrease the Sensibility, you will hear a 2 beeps sound
When you reach the limit, you will hear a continuous sound

ZEROIZE

Launching the Zeroize option you will reset all variables to default values.

How it works:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Trigger2 -> Zeroize will set all variables to default values.

MEMORY SLOTS

The FSSB R3 has four memory slots to save custom configurations. "Memory Slot"
makes custom option of the R3 handling very comfortable to use in flight. With only 2
actions (enter SMM mode + one button press) select a large bunch of parameters.

How it works:

To program a profile (save the configuration in the slot)

Configure the R3 as you like even SMM, and:

Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press Paddle and hold it pressed.

Press CMS in one way for two seconds.

UP -> Slot 1.
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RIGHT -> Slot 2.
DOWN -> Slot 3.
LEFT -> Slot 4.

To recover a profile (load data from the slot and configure the R3)
Press SMM launcher whatever it be (CMS center or Paddle + Pinky)
Press CMS in one way for two seconds.

UP -> Slot 1.

RIGHT -> Slot 2.

DOWN -> Slot 3.

LEFT -> Slot 4.

When R3 power up, auto load the Memory Slot 1 if available.

PRECISION MODE ON/OFF
You can enable and disable the precision mode with Pinky + TMS or DMS Up.

If enable, when you press Pinky the sensibility in axes will change to half.

SWAP ROLL/YAW

The main feature of SSF is the ability to swap between Roll and Yaw axes. This
happen when your press pinky; by default, with Pinky released your X axis drive the
Roll and when you press Pinky your X axis drive Yaw, but you have the possibility to
invert this and also to do permanent the actual selection, we will show:

- Pinky + TMS or DMS Down, do permanent the actual selection and pinky don’t
swap the axes.
- Pinky + TMS or DMS Left:

o If we come from “permanent” this action will disable permanent and the swap
Roll/Yaw system will become active with Pinky. This is called “momentary”.

¢ |If we come from “momentary” the actual Roll/Yaw axes will be swap; to swap
again and goes to previous situation press Pinky + TMS or DMS Left again.

ENABLE/DISABLE KEEP RATE

You can change between enable and disable the Keep Rate mode with Pinky + TMS
or DMS Right.

If enable, every time you swap between Roll/Yaw axes, the keep rate of the swapped
axis will be kept; this let you keep the roll keep while you modify the yaw to turn over
and shoot your opponent.
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EMYCSA Setting up your game for the FSSB-R3L
RealSimulator | ... »9.12.2022

Version: 3.01

PICTURE
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I¥C Server
Avionics Configurator

\\ Editor

DESCRIPTION

Overview

This section is focused mainly for beginners to give them a first overview on how to
configure the main flight simulation games to integrate correctly the FSSB-R3L.

Although these programs have an extensive documentation where the user can find
solutions and explanations to all his doubts, here we will guide you giving an initial
orientation about of how to configure them and the different possibilities that your device
offer. We will see the procedure on Falcon BMS 4.34 and on DCS.

Before to launch your simulation program you should check your system and verify your
game devices are properly installed. As surely you have already read W10 has an
important bug with composites devices (like the FSSB-R3, TUSBA, etc.) and sometimes
the devices are not installed properly. It rarely occurs, but can occur after a new device
is connected and installed, changing the connected devices configuration.

For that, open your Game controller window and check the devices are correctly
installed verifying every device has the axes and buttons that you hope it has. As
general rules keep in mind these:

e No matter the device order in the Game Controller window.
e The first device of a composite device in the list has the axes.
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Here you have an example:

#¥ Dispositives de juego

- Estas opciones le ayudan a configurar los disposttivos de juego
"'; instalados en su equipo.

Dispositivos de juego instalados

Dispositivo

RS5-F16-5G-RH-HOME

Aceptar

| 516 SaAMHONE
FS5B R3L MJF 5GRH

L -, - - S

Aceptar
FSSB R3L MJF SGRH Aceptar
RS_TUSBA_RZ Aceptar

| Opciones avanzadas... Propiedades

Aceptar

As you can see there are three game devices connected to the computer: the
F16SGRH, the FSSB-R3 Lighting and the TUSBA for the F-16 throttle.

As you have already read in this document we suggest unpairing the F1I6SGRH if we
use it with the FSSB-R3L to avoid duplication of information. So, the first thing we will
do is unpair this device using the Remove device windows action of Devices and printer
window.

& FS58 R3 MIF SGRH properties x
Setings [Tol
Test the game controller. F the controller is not funcioning properly, & may
70810 be calbrated To Calbrate 1, 9010 e Setngs page.
hese
+
ﬂ}m-‘n\m‘
Butons Pt f e Ht
s000000S
[ E XX XXX N °
eseccece
1
#§ Dispositivos de juego * 60000000
o] o | G
- Estas opciones le ayudan a configurar los dispositivos de jusgo
'.; instalados en su equipo.
B P55 R3 MIF SGRH properties x
Dispositivos de juego instalados Bt [ Tod_
i o e ot e Sererage A
Dispositivo Estado / - e
FS5B R3L MJF SGRH Aceptar
FS5B R3L MJF SGRH Aceptar ~
—>
Busons
[ A XX NN NN ]
[ AR RN NN N
00000000
Opciones avanzadas... Propiedades 'YX
=]
Aceptar
- _ o Propiedades de RS TUSBA R2 x
Corfiuraciin | Frusba |
Frusbe o daposti de uego. S o incona conectanerts. calirela
Para cho. vaya 2 s Corbasacin
- —
[
[ e
" N oo T
e
| Eex/Ber NN Corvodesate
Botomes

[ oestar ] | Cancelar
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As you can see in the previous composition image both mentioned rules are met.

Finally, there is an important concept you must remember: how your device can interact
with the game. Although surely you know it, | will repeat it; your device has got the next
features:

e Two analog axes: Pitch and Roll.
e 32 x 2 DX buttons.

e 8 slots, and each slot 64 configurable and independent keystrokes (only the
Lighting model)

Now with the assurance our hardware is correctly installed, we can start to configure
our simulation program. We will do it with the next two connected devices: FSSB-R3
and TUSBA.

FALCON BMS

Within the extensive information and manuals that this program has, there is a great
guide named BMS Device Setup Guide where you will find all the information
necessary to configure properly your devices and program. As we mentioned before
here we are going to help inexperienced users to lose their fear to start.

The integration of FSSB-R3 in the program is done assigning the analog axes and
assigning the DX buttons and keystrokes to actions such as “Gears Up”. These actions
are executed internally through Callbacks, so the “Gear Up” action is the callback
“‘AFGearUP’.

AXES

Axes are assigned easily through the game control panel. Launch the program and click
on Launch, next the SETUP option and finally in CONTROLLERS.

(BSTAMTACTON  SOGAGNT TACIKANGAGIMINT  CAMMGN | TACTIA MFLMACE | COMMS  \OGIOON AW TR ue gl |

Now to assign the X and Y axes of FSSB-
R3 to the Roll and Pitch axes of simulator,
click on CONTROLLER and select from
the drop down list as main controller the
first FSSB R3 device.

CONTROLLER
L MJF EiERH
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After this you can move the stick and check the center ball of X/Y graphic responds to
your movement.

Also you can check the 8 JOYSTICKS BUTTONS work when you press the grip
buttons.

AdOYSTIGK EUTTONS

e Sl1: Trigger 1 e S5:NWS

e S2: Weapon Release e S6: Trigger 2
e S3: Pinky e S7:TMS Up

e S4: Paddle e S8: TMS Right

Finally, click on the ADVANCED button to assign the other TUSBA axes. In the new
window click on the FLIGHT CONTROL tab to assign the Throttle and in the AVIONICS
CONTROL tab to assign the Radar Anntenna Elevation, Cursor X, Cursor Y and
Range Knob according to thefollowing assignment:

Cursor X: X Axis — RS_TUSBA_R2 (2)

Cursor Y: Y Axis — RS_TUSBA_R2 (2)

Range: Y Axis — RS_TUSBA R2 (2)

Antenna Elevation: Rotation X — RS _TUSBA_R2 (2)
Throttle: Rotation Y — RS_TUSBA_R2 (2)

Advanced ¢ptions Advanced Options

5 V'EW CoOnTROL Aupio CONTROL W L Al

fuds XIS §aturation Reverse DeadzZone Saturation Reverse
Rat. A 1 Small HNone

=

m O [ O &I

Trim Yaw
Keybaard

I O [ O @

Finally, click OK to save the configuration.

DX BUTTONS

Now we are going to assign the DX buttons and keystrokes to the desired actions. In
this program it is done through the “Key file”, but what is a “key file”? Next | copy the
explanation given by the BMS guide:

The key file defines all key mappings on a keyboard for the various functions we have in Falcon BMS.
The functions are invoked via keystrokes, either a single key (e.g. “A”) or a combination of modifier
keys (Shift, Alt, Control) and a key (e.g. “Shift Alt A”).

In addition to that they contain also all DirectX bindings to control input devices. A DirectX input
device returns a button number which is recognized and interpreted by Falcon BMS. You can now say
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if | press button “A” on the device bind that to a specific function (e.g. fire the gun).

Key files are located in the .../User/Config folder. We have five different standard key files in Falcon
BMS.

There are four different key file profiles which use the same keystrokes layout: Full, Basic, Minimum,
Blank and Pitbuilder.

The standard key files above do not contain DX bindings. This is because there are too many different
devices with different button layouts out there. You need a specific solution for each device
respectively.

Yes, as you have read there is a file (the
key file: *.key) where are defined the key
mapping which relates the functions
(callback) to the keystokes that are the
event we can generate with our keyboard or
simulation device. This file, as we will see
below, also includes the DX buttons.

CURRENT KEYFIL =

The name of key file in use is shown in the
SETUP control panel, in our actual case
“‘BMS-FULL” and below is shown as a table
format the key mapping where we can see
the assigned funcion of every key. T

If we open this file we will see how is its internal structure. It is composed for lines that
follow a format:

SimTMSUp -1 00xC7 100 1 "STICK: TMS Up"
SimTMSDown -1 0 0xCF 1 00 1 "STICK: TMS Down"
SimTMSLeft -1 00xD3 100 1 "STICK: TMS Left"
SimTMSRight -1 0 0xD1 1 00 1 "STICK: TMS Right"
SimDMSUp -1 00xC7 200 1 "STICK: DMS Up"
SimDMSDown -1 0 0xCF 2 0 0 1 "STICK: DMS Down"
SimDMSLeft -1 00xD3 2 00 1 "STICK: DMS Left"
SimDMSRight -1 0 0xD1 2 0 0 1 "STICK: DMS Right"
SimCMSUp -1 00xC7 400 1 "STICK: CMS Up"
SimCMSDown -1 0 0xCF 4 00 1 "STICK: CMS Down"
SimCMSLeft -1 0 0xD3 4 00 1 "STICK: CMS Left"

Some time ago this file had to be modified manually, so you had to be an expert to do it.
Nowadays exists a tool named “BMS Key File Editor.xls” where you can configure the
key file to you liking, and to help you in that task it has a manual ("“BMS Key File Editor
Manual.pdf”) where you will find an extensive explanation about the how to do it.

If you have a FSSB-R3 Warthog or a FSSB-R3 Lighting with the classic firmwares, your
device are not able to send keystrokes, so you will need to use the DX buttons.
For this, folow the next steps:

e Open the BMS Key File Editor.xIs file with your Excel program.

e Click the Keystrokes Editor tab and select the Keyboard Layout (Locale) you
prefer, for commodity and standarization “US International”.

96 /110




e Click on the Import Key File button to import the key file, in our example “BMS —
Full.key”.

e Verify the M3 cell show in green the text: “Imported Key File is OK”.

e Select the TM Warthog tab and choose the option Warthog Stick only. This file
only use the 19 first DX buttons, if you want use the rest of available buttons you
will have to modify the profile creating a new profile from this one in the existing
tabs named Own #1 to Own #10.

i B c D EIN
; Quicklinks: || Read Me IH Keystr. Editor I|| DX Settings I|| Most Wanted I
2 Controller # HOTAS: 1 Mot set as input device.
: Pinky Shift: ok
11 | manual. DX Seftings sheet, make s1

12 | You can chooses Stick only if you want to use your Warthog stick together with other Throttle devices
13 | (e.g. CH Throttle). There is a separate sheet for the Warthog throttle as well.

has been imported and the

14
15 Choose Stick & Throttle or Stick only: | Warthog Stick only | ( |
|

o Stick (Device A) O
19 Unshifted (Normal) Layer

20 |DX Button # Button Description Edit this column enly

21 Do NOT drag & drop!!! Just Paste Specials (Values ONLY!!!)

22 1 TG1 (Trigger 1) SimTriggerFirstDetent

23 2 52 (Pickle) SimPickle

24 3 83 (Pinky) SimHotasPinkyShift

25 4 S4 (Paddle) SimAPOvarride

26 5 S§1 (MsiStep) SimMissileStep

27 6 TG2 (Trigger 2) SimTriggerSecondDetent

28 7 H2U (TMS Up) SimTMSUp

29 8 H2R (TMS Right) SimTMSRight

30 9 H2D (TMS Down) SimTMSDown

i 10 H2L (TMS Left) SimTMSLeft

32 11 H3U (DMS Up) SimDMSUp
El 12 H3R (DMS Right) SimDMSRight

k! 13 H3D (DMS Down) SimDMSDaown

35 14 H3L (DMS Left) SimDMSLeft

36 15 H4U (CMS Up) SimCMSUp

37 16 H4R (CMS Right) SimCMSRight

38 17 H4D (CMS Down) SimCMSDown

Note: for convenience and not to complicate this example we use the TM
Warthog profile for the FSSB-R3 device)

e Selectthe TUSBA TQS tab and select the TUSBA version.

Quicklinks: H Read Me IH Keystr. Editor I|| DX Settings I|| Most Wanted I
Controller #: Throttle: 3
Pinky Shift: No Pinky Shift assigned.

1 device, 32 DX buttons, two layers possible (1

3
: TUSBA TQS R1/R2 - DX Buttc
7
9

Use this sheet to change DX programming for the RealSimulator TUSBA TQS R1/R2 devices if you Notes:
10 | intend to uses TUSBA together with a different Stick than Cougar or Warthog (refr to TM Combos
11| in this case).
12 | There are two different versions of the TUSBA device. R1 and R2. Please refer to RealSimulator
13 | for more information about the differences. Some functions are not available with the R1 version.

If no imported data is available, sel
DX Settings sheet, make sure a ket
has been imported and the comrect

14
15 Choose TUSBA Version: |TUSBA TQS R2 | |
17 TUSBA TQS (111rott|e) Own Remark

Unshifted (Normal) Layer

20 |DX Button # Button Description

21 Do NOT drag & drop!!!
22 1 Comms Off (Center)

23 2 Comms VHF (Down)

24 3 Comms UHF (Up)

25 4 Comms IFF In (Right)

26 5 Comms IFF Out (Left)
27 G MSTR-Mode Off (Center)
28 7 DGFT (Fwd)

Edit this column only

Just Paste Specials (Values ONLY!!!)
SimDoNothing
SimTransmitCom2

SimTransmitCom1
SimComms SwitchRight
SimCommsSwitchLeft
SimDeselectCverride

SimSelectSRMOverride

e Select the DX Settings tab and assign the devices you are ussing: FSSB-R3
(TM Warthog) and TUSBA. And assign the Controller # order number (1 and 3)
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B C D E F G H | J KILMN O P Q

DX settings are o

Quicklinks: “ Read Me I“ Keystr. Editor IH Import IH Output IH DX Specifics I Options

1
2 -

E DX Settings

5 Note: If you are not familiar with this tool or don't know what it does at all, please read the instructions first!

[

7 Step 1: Set Pinky Shift Magnitude: Select: Maximum devices: Shifted L ayers- Check: Comments:

8 (equals ¥ of unshifted layers) Shifting possible for;

9 8 Controller# 1 - #8. No conflicts found.
1 | MNote: 256 is the default value_ If this value is ok here, you don't need to change it in the Falcon BMS cfg.

12 Do NOT drag & drop!!! Just Paste Specials (Values ONLY!!!)
13 Step 2: Set your devices: Select: Link to device: Controller #: Check: Comments:

14 1st 2nd

15 Primary Input Device: Trustmaster HOTAS Warthog II' I:| No conflicts found.
17 1st Additional Device: TUSBATQS | RealSimulator TUSBA TQS R1/R2 ] No conflicts found.
19 2nd Additional Device: I:l |:| No device selected.
| I:I I:l |:| No device selected.
23 I:I I:l I:l No device selected.
25 I:I I:l I:l No device selected.
27 I:I I:l I:l No device selected.

e Click on te Output tab and check that in the end of A column there are new lines
with the code to support the DX buttons of your devices. You can see three new
heads for code: STICK UNSHIFTED, STICK SHIFTED and TUSBA
UNSHIFTED.

e Select the Keystrokes Editor tab and click on the Export Key File button to
save the actual custom profile. | suggest changing the file name to keep always
the original files in the folder installation (BMS — FULL SAMPLE .key)

e Now you can open the FALCON BMS program and access to the
CONTROLLERS control panel in the SETUP menu and verify the new code
added works fine. For that click on the LOAD button and select the recent saved
key file.

CURRENT K EYFILE
MAPPING

BMS - Full

ADVANGCED

INPUT Button 11
ETICK: DME Up

If you check the key file on the added code there is a line for the button 11 of
Stick (on the file appear as 10, you can find more information about this
difference in the guide) :

SimDMSUp 10 -1 -2 0 0x0 -1

And this Callback SIimDMSUp in other part of file focused for keystrokes has
associated the text “STICK: DMS Up” that you see when press the button.

SIMDMSUp -1 0 0xC7 2 0 0 1 "STICK: DMS Up"
e You can repeat the action with other buttons to verify them.

KEYSTROKES

If you have a FSSB-R3 Lighting with a firmware installed with support for keystrokes
generation as the released MJF_F16-18 4 that has keyboard emulation, you can use
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this option.

As we said before in previous sections, it is the key file who has the key map with the
relation between the keys and the actions. Fortunatly it is already done the great work
of generate the files and the keyboard layout to help us.

We will show with an example how to add a new action to to our FSSB-R3L, we are
going to add the action “EJECT” to the Weapon Release Up button.

In this case we look at the file BMS Keyboard Layout.pdf to search the action and see
which is the necessary key to generate this action. In this case the action is created and

as you can see is “CTRL + E”, if not, we would

BMS guide instructions.

need modify the key file following the

Esc F1 F2

F4

F5 F6 F7 F8 F9

F10

F11

F12

it Sim CP COM1 lcP com2 IcP IFF CP LIST CP A-A IcP A-G IR Precision 1R Profile 1R Pause. RAPS Sersen RAPS Benchm.  [[TIR Recantsr
ire&Oheat Detect |Oxv Oty Switch  [[MalindLts Hold robe Heat Up robe Heat Dn  [[EPU GEN Switch  [[FLCS PWR Test 18 Flap Down  [[F-18 Flap Up
adar Range Dn  ([Radar Range Up ~ [HSD Range Decr  [HSD Range Incr ntEley On ntElev Center ntElev Up laps Null [Fiaps Full laps Dec laps inc
[Man Range Dn 4an Range Up efs Null efs Full efs Dec efsinc
NI Knob Tog oft Channel Up  (|Centr Channel Up [IRight Channel Up hannel Tog X/¥  (|station Sel Tog laster Down laster Up -4 Code Hold 4 Code Zero eply Cycle fonitor Toggle
nable Cycie eft Mode | Up ight Mode | Up (et Mode 3 Up ight Mode 3 Up rom L wing Dn  |[riim & Wing O |[75im Nose Up Trim/AP Tog
igital Sw Toggle |[Ak Flaps Tog an TF Fiyup Tog ||LE Fiaps Tog LGS Switch it Switch Trim Yaw Left [Trim aw Right  [Trm Nose Dn

AN

ctrl

Shi

N

GREEN ITALICS
LIC:

RED ITALICS

=

1 2 3 5 6 7 8 9 [ - = Backspace
stelite Cam ud Only nap Pit (30) an Pit (30) adiock xended FOV GtioSelfCam  |Jncoming Cam riencly AC Cam  [icnase Cam roit Cam Padlock Prev adiock Next
laction Cam mpty Ckpit Shell [[5A-Bar Padiock Mode A4 [EFOV Mode AA  [[Target Cam €apon Cam riendly GU Cam  [[Fiyby Cam Dispicmnt Cam  [Padlock Prev AA  [Padiock NxtAA  [ICP NAV Mode
PrettyFiming Iinfobar ublities ap Display Enaine Display o0 CustomView  |[Tatto Wpn Cam  |Enemy AC Cam  [TopGun Cam [EvFly Free Cam  [Padlock Prev AG  |Padiock NxtAG | Cycle Enaines
Labels Near |Labets Far Clickabl Pit Mode  [Mouse Bins Tog  [Padiock Mode AG [EFOV Mode AG  [Prev Custom \iew [Pixt Custom View  [Enemy GU Cam  |TopGun Prev opGun Hxt Pprev Aircraft Next Aircraft Next AG Weapon
[Radar Gain inc MFD 0SB 1 MED 0SB 2 MFD 058 3 MFD 0SB 4 MFD 0SB 5 MFD 0SB 6 MFD 0SB 7 MFD 0S8 8 MFD 0S8 9 MFD 0SB 10 MFD Bt Dec MED Brt inc
|Radar Gain Dec  |[LMFD 0SB 1 MFD 0S8 2 MFD 0SB 3 MFD 0S8 4 MFD 0S8 5 MFD 0SB 6 MFD 0587 MFD 0588 MFD 0SB 9 MFD 0SB 10 MFD Brt Dec MFD Brt Inc
Tab a W T 1 0 P T i
[Time Accel 2x wacs Menu ingman Menu || [Eiementmeny  [Fifht TC Menu anker Menu lanRng Uncage  |Jnsir Mode Cyc PO Tog oggle Pause  [HMCS Bright Dec [HMCS Bright Inc
[Fime Accel Up uel Qty Up [Wing Fold Tog || [[Safety Lever Tog [l pen Chat Box  |[Rdr Cursor Stop xy Sefd Cye oggle Freeze omm1 Vol Dec "m1 Vol Inc
uel Qiy Dn [EJECT R omm2 Vol Dec  [Comma2 Vol Inc
[EPU Sw Cyel Trust Reverser die Detent - Toa. [MPO Hoid arking Bri Toa  [[Intercom Vol Dec  [Intercom Vol Inc
uel Master Tog  [(Eng Feed Dn ng Feed Up \nt Coll Lts Tog  |[Position Lis Tog | WingsFus Lts Tog 5L Vol Dec ISL Vol inc
tain Pwr Step O (|Main Pur Step LS Knob Tog om1 Mode Tog  ||com2 Mode Tog  |[Threat VorDec  [frareat Vol inc
lEcM Opr Tog ng Gont Tog Vol Knob Decr Vot Knob ner
18 770 Trim
Taps Lock 5 F K : v Return
[Time Accel 4x lap Swiich IDF Ovemde VTR Sw Tog car Toggle [HUD Scales Cy  |[Toggle Jammer heelBrakes  [Look Closer HSI Hdg Dec 5°  [HS1 Hag Inc 5° faster Caution
[Time Accel Dn s potight Iprag Chute Depl ~ [[Fuel Trans Tog I Gear Reset  [[HUD DED Cyc FSTogStart  [Release Catapuit [Lndg Lights Tog  [[HS1 Hdg Dec 1* |51 Hdg nc 1 CP Drift cfo Wam
moke Toggle Hom Silencer  ||HUD Velocity Cye [Emergency Jett  [Hook Tog Laser SwTog  [HSICrsDecs®  [HSICrs Inc |Caution Resst
[Fuel Dump VIR SwCycle  ||altGear Exteng  [IHUD Color Cye ND Jett Tog HSICrs Dec 17 |1 Crs inc 1 im Reset
UHF X___Dn (lumFx___up |JumF _x. —_Up |uHF_x_up |unF it Press - 5 it Press + 5
unction Step Up ||Mode Step D it Press - 1 Ut Press + 1
L IR Pwr Tog WS Pur Tog 15 lcH Pur Tog L Pr Tog et Sw Toggle ISP Pwr Toggle
18 LBar Tog
il z c v B N ™M s . 1
[Prev. Waypoint  [[Next Wavpoint RMIDF Cancel  |[Pinky Switch ISodBric Toa VG Toadle MRM Override  [Rudder Left udder Riaht
[Form Lights Dn  [Form Lights Up ~ [[CAT Sw Tag JSpdBrk Open Master Am Cyc  |[Viol Exhaust Dec  [[Viol Exhaustine ~ [INWS AR MSL
. [PRGM Knob D |IPRGM Knob Up ~ [[Canopy Toggle  [IVMS Sw Tog JSpdBrk Close Master Lts Tog  |[Drop Chaff Drop Flare 15t Trigger Det .
S h i ft cMDS Moge Dn  flcMDS Moge Up  [lkevComba Visor Toagle na Triager Det S h I ft
IRight Hdpt Tog  ||Left Hdpt Tog CR Sw Tog IRDR it Din DR At Up UD FPM Cye UD Deprfet Cye |[HUD Alt Cye HUD Brighin Cyc
lPri DED Gyc lPri inst Pni Gye  |[Fid Cansoles Gye ir Source Dn ir Source Up
\ IS Knob D s Knob Up CC Sw Tog M3 Sw Tog IFD Sw Tog UFC sw Tog l6Ps sw Tog L Sw Tog 14 Sw Tog
Keypress Modifier: Legend: Space \f
Unmodified BLACK BOLD WPN Release
GREEN BOLD
il BLUE BOLD
ctrl | Alt |: AltGr | Ctrl
Shit + Gt BLAGK ITALICS

Now we need add this keys to our FSSB-R3 profile.

So, open the RS_HID_DEV_TOOL and choose the slot where add the action. We
choose for example the Slot 3 and next press the textbox of WR Up; if you don’t know
where is it, press the Names button or press directly the button and locate the DX
button lighted. In this case is the DX button 19.

After press the textbox you can enter the keys “CTRL + E”.

02 |

|° ’Eaa‘

lo @z,

e,

|a lf“a‘ |CI [43%,

o . b o 4%,
a ,Eaa
Actual Key Code Empty PR
LAV Macro | | ARWin. o [47°%,
Press new Key Code LCtd E,
EEEEE  CLeAR ok ]
WR UP

A » l Trim Roll n

Axes Measure

32768

Roll X
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After click the OK button you can check it in BMS Falcon.

SIMULATION

ERAPHICE

CURRENT KEYFILE

SETTINGS FOR:

I: CONTROLLER

FESE RAL MUF SERH

ADVANCED

INPUT Ctrl e

SEAT: EJECT Handle =

D ANGEL

As you can see, it is a very easy method and also allows you introduce until 8 x 64
differents actions.

Finally, as general rule, don’t forget disabling always the DX Button button in the slot
where you use Keystrokes.

DCS

In DCS there is only a way to integrate the devices in the program; it is with the control
panel. You will find it in the CONTROLS tab of OPTIONS menu and it allows you to
customize your control input devices, such as joysticks, mouse, keyboards, rudders,
etc. profile assigning to every action the axis or keystroke you choose.

PRT—

Also you can see in this control window there is in the left a column to show the
assignable actions, next a column where is shown the category of each action and
finally a column for each detected input device, in our example: keyboard,
RS _TUSBA R2, FSSB R3L MJF SGRH (second device of R3L), FSSB R3L MJF
SGRH (first device of R3L) and the mouse.

By default, as you can see the program assign a profile to all input devices assigning
default actions to the available axes and buttons of input devices. Also, it starts with the
General profile, as we are going to prepare the F-16C profile we will select the F-16C
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Sim on the Aircraft Control Mode drop down.

AXES

In our example, we will use the two axes
of FSSB-R3L for Pitch and Roll, that as
you have seen before they are located in
the first HID device of FSSB R3L. For
throttle we will use the TUSBA device.

For that, select in the Input Categories
drop down the option Axis Commands.

As you can see the Roll and Pitch axes is
associated to 2 input devices, if you move
the stick, you will see how a line under the

Digital Combat Simulator

OPCIONES

SISTEMA JUGABILIDAD

F-16C Sim odo Reinic.

texts moves, thereby we will verify which are the axes we are Iooklng for.

Digital Combat Simulator

OPCIONES
SISTEMA CONTROLES JUGABILIDAD

F-16C Sim

Comandos de Ejes

Acciér Categoria

Alabeo

MISCELANEO AUDIO

Reinic. categoria por defecto

ESPECIAL VR

Borrar categoria Guardar perfil como Cargar perfil

Keyboard RS_TUSBA R2 {563 3L MJF SGRH..  FSSB R3L MJF SGR
Jov_X

AOA Indexer Dimming Lever
Indicator Dimming Lever

Control de brillo de la linterna

Panel de instrumentos
Panel de instrumentos

Consola derecha

After verify it, we will delete the other JOY_X and JOY_Y in the other device with left
click mouse on the desired place to select it and left click on the CLEAR button.

Also we will delete the other axes asociated with the FSSB R3 because this device only
has this two axes (red boxes).

Finally we will assign the Throttle and other auxiliary axes of TUSBA device. This is the
axes assignation on TUSBA:

JOY_X: Cursor X

JOY_Y: Cursor Y

JOY_Z: Range

JOY_RX: Antenna Elevation
JOY_RY: Throttle

JOY_RZ: Idle

JOY_S1: Militar

JOY_S2: AfterBurner

After checking the default assignation of axes on TUSBA, we verify that Cursor X
(JOY_X), Cursor Y (JOY_Y), Range (JOY_Z) and Antenna Elevation (JOY_RX) are
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well configured (green boxes) but the Throttle axis is bad assigned, it is assigned to
JOY_RZ and it must be JOY_RY; so first we will delete the actual axis and after we will
assign the axis to the correct value by double click over the box and selecting JOY_RY.

OPCIONES

We have finished the axes configuration, so it is a good moment to save our
configuration by click on the SAVE PROFILE AS with the name F16_Sample.

POINT OF VIEW

Now we are going to configure the Point Of View (POV), for that select in the Input
Categories drop down the option View and we will scroll the list until finding the View
Down Left slow field. As you can check the default profile has already assigned these
actions to the three devices but as in our phisical device configuration only has POV the
first device of FSSB R3 we will delete the non necessary assignations (red box) and will
maintain the valid (green box).

Digital Combat Simulator

OPCIONES

SISTEMA JUGABILIDAD MISCELANEO AUDIO ESPECIAL VR

F-16C Sim Reinic. categoria por defecto Borrar categoria Guardar perfil como Cargar perfil

Keyboard RS 2 {563 FSSB R3L M

RCtrl + F8
- Vista de objetivo Vista F8
- Vista de barco Vista F9
LAIt + F9

8 - Filtro de objetivos del jugador/todos los objetivos Vista

cial de senales de aterrizaje Vista

) Vista LCtrl + [

Ratén - Régimen normal Vista LAIt + [
LShift + [
Teclado - Régimen lento Vista LCtrl + ]

Ratén - Régimen rapido Vista

Teclado - Régimen normal Vista LAIt + ]
Teclado - Régimen rapido Vista LShift + ]

Vista a la derecha lentamente

uierda lentamente
Vista abajo a la derecha lentamente
Vista abajo a la izquierda lentamente
Vista abajo lentamente
Vista arriba a la derecha lentamente
Vista arriba a la izquierda lentamente
Vista arriba lentamente
Zoom externo hacia dentro
Zoom externo hacia fuera
Zoom externo normal
Zoom hacia dentro lentamente
Zoom hacia fuera lentamente

Zoom normal

Modificadores

Vista
Vista
Vista
Vista
Vista
Vista
Vista
Vista
Vista
Vista
Vista
Vista
Vista

Numé

Num4

Num3

Num1l

Num2

Numg

Num?

Num8

RCtrl + Num*
RCtrl + Num/
RCtrl + NumEntrar
Num*

Num/
NumeEntrar

Predefinido Asignar eje

JOY_BTN_POV1 Dr
JOY_BTN_POV1 Iz
JOY_BTN_POV1_AbjDr
JOY_BTN_POV1_Abjiz
JOY_BTN_POV1_Abj
JOY_BTN_POV1_ArrDr
JOY_BTN_POV1_Arriz
JOY_BTN_POV1_Arr

Ajustar eje

JOY_BTN_POV1_Dr
JOY_BTN_POV1_Iz
JOY_BTN_POV1_AbjDr
JOY_BTN_POV1_Abjiz

JOY_BTN_POV1_Abj
JOY_BTN_POV1_ArrDr
JOY_BTN_POV1_Arriz
JOY_BTN_POV1 Arr

Ajustar FF

JOY_BTN_POV1_Dr
JOY_BTN_POV1 Iz
JOY_BTN_POV1_AbjDr
JOY_BTN_POV1_Abjlz
JOY_BTN_POV1_Abj
JOY_BTN_POV1_ArrDr
JOY_BTN_POV1_Arriz
JOY_BTN_POV1_Arr

You can verify that these are the valid assignations moving the TRIM switch. You will
see the next image when you press it forward.
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Vista LShift +
Vista Numé JOY_BTN_POV1 Dr JOY_BTN_POV1_Dr JOY_BTN_POV1 Dr
y Vista Num4 JOY_BTN_POV1 |z JOY_BTN_POV1 Iz JOY_BTN_POV1 Iz
Vista abajo a la derecha lentamente Vista Num3 JOY_BTN_POV1 AbjDr  JOY_BTN_POV1 AbjDr  JOY BTN b
Vista abajo a la izquierda lentamente Vista Numl JOY_BTN_POV1_Abjlz JOY_BTN_POV1_Abjlz

Vista abajo lentamente Vista Num2 JOY_BTN_POV1_Abj JOY_BTN_POV1_Abj
Vista arriba a la derecha e Vista Num9 JOY_BTN_POV1 ArrDr  JOY_BTN_POV1 ArrD
Vista arriba te Vista Num?7 JOY_BTN_POV1 Arriz JOY_BTN_POV1_Arriz

Vista Num8 JOY_BTN_POV1 Arr JOY_BTN_POV1 Arr
Zoom externo hacia dentro Vista RCtrl + Num*

And this will be 